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Safety Notices

CAUTION

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like 
that, if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and 
met.
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1 Safety and Regulatory Information

Safety Information

Safety Summary
The following general safety precautions must be observed 
during all phases of operation of this instrument. Failure to 
comply with these precautions or with specific warnings 
elsewhere in this manual violates safety standards of design, 
manufacture, and intended use of the instrument. Agilent 
Technologies, Inc. assumes no liability for the customer's failure 
to comply with these requirements.

Safety Notice

General
This product is provided with a protective earth terminal. The 
protective features of this product may be impaired if it is used 
in a manner not specified in the operation instructions.

CAUTION A CAUTION notice denotes a hazard. It calls attention to an 
operating procedure, practice, or the like, that, if not correctly 
performed or adhered to, could result in damage to the product or 
loss of important data. Do not proceed beyond a CAUTION notice 
until the indicated conditions are fully understood and met. 

WARNING A WARNING notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or 
adhered to, could result in personal injury or death. Do not proceed 
beyond a WARNING notice until the indicated conditions are fully 
understood and met.

WARNING DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE. Do not operate the 
product in the presence of flammable gases or flames.
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Environmental Conditions
The Agilent U1840A Medalist sj5000 Automated Optical Inspec-
tion System is designed for indoor use only. Table 1-1 shows 
general environmental requirements.

WARNING DO NOT REMOVE RACK PANELS OR INSTRUMENT COVERS. Operating 
personnel must not remove any rack panels or instrument covers. 
Component replacement and internal adjustments must be made only 
by qualified service personnel. Products that appear damaged or 
defective should be made inoperative and secured against unintended 
operation until they can be repaired by a qualified service personnel.

WARNING The protection provided by the Agilent U1840A Medalist sj5000 
system may be impaired if the system is used in a manner not 
specified by Agilent.

Table 1-1    Environment Requirements

Environment Conditions Requirements

Maximum Altitude 2000 meters 

Temperature (Operation) 5 C to 40 C

Maximum Relative Humidity The test system is designed to operate 
in the range from 5% to 80% relative 
humidity (non-condensing) with 80% 
for temperature up to 31°C, decreasing 
linearly to 50% relative humidity at 
40°C

° °

CAUTION This product is designed for use in Installation Category II and 
Pollution Degree 2, per IEC 61010-1 and 664 respectively. The 
operating voltage should be in the range of 100-120 VAC/200-240 
VAC, 50/60 Hz (8 A) with the Mains Supply Voltage fluctuations not 
to exceed ±10% of the nominal voltage.
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1 Safety and Regulatory Information

Before Applying Power
Verify that the product is set to match the available line voltage 
and all safety precautions are taken. Note the external markings 
of the instruments described in “Regulatory Markings”.

Ground The System
To minimize shock hazard, the instrument chassis and cover 
must be connected to an electrical protective earth ground. The 
instrument must be connected to the ac power mains through a 
grounded power cable, with the ground wire firmly connected 
to an electrical ground (safety ground) at the power outlet. Any 
interruption of the protective (grounding) conductor or 
disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Fuses
Use only fuses with the required rated current, voltage, and 
specified type (normal blow, time delay). Do not use repaired 
fuses or short-circuited fuse holders. To do so could cause a 
shock or fire hazard.

Operator Safety Information

Cables and connectors are considered inaccessible if a tool (e.g. 
screwdriver, wrench, socket, etc.) or a key (equipment in a 
locked cabinet) is required to gain access to a conductive 
surface connected to any cable conductor (High, Low or Guard).

WARNING In order to avoid electrical hazards, all system internal fuses must 
be replaced by trained and qualified personnel.

WARNING
M

Module connectors and Test Signal cables connected to them 
cannot be operator accessible.

WARNING Assure the equipment under test has adequate insulation 
between the cable connections and any operator-accessible parts 
(doors, covers, panels shields, cases, cabinets, etc.)
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Verify there are multiple and sufficient protective means (rated 
for the voltages you are applying) to assure the operator will 
NOT come into contact with any energized conductor even if 
one of the protective means fails to work as intended. For 
example, the inner side of a case, cabinet, door cover or panel 
can be covered with an insulating material as well as routing the 
test cables to the front panel connectors of the module through 
non-conductive, flexible conduit such as that used in electrical 
power distribution.

Safety Requirements
The following is a list of the safety requirements for electrical 
equipment for measurement control and laboratory use:

• IEC 61010-1:2001 / EN 61010-1:2001

• Canada: CSA- C22.2 No.1010.1:1992

• USA: UL 61010A-1 :2002

See certificate for list of relevant standards.

Machine's Intended Use
In addition with the above environmental conditions, the 
machine is designed to be used solely in a Surface Mount 
Technologies (SMT) production line. 

CAUTION This machine must only be used with conveyors on both sides 
either in-line or in off-line operation. This is to prevent users from 
accessing pinch points inside the machine.
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1 Safety and Regulatory Information

Electrical Safety

Electrical Enclosure
Live power and control circuits are situated in various parts of 
the machine. 

• The Main Control Panel is accessed through the rear access 
panel, which is mechanically locked. 

• During the Off position, the machine only has main voltage on 
the primary side of the Main Isolator.

Emergency Stop Loop
The Emergency Stop (E-Stop) is designed according to the 
relevant safety standard. It is controlled using a Carlo Gavazzi 
Class IV safety relay.

Refer to the hardware manual for E-stop locations on the 
sj5000. The E-stop system is also activated by opening the 
system's front access door.

WARNING LETHAL VOLTAGE
DANGEROUS VOLTAGES EXIST IN THIS EQUIPMENT. ENSURE 
THAT ALL ELECTRICAL ENCLOSURE COVERS ARE FITTED AND 
INTACT BEFORE OPERATING THE EQUIPMENT.

NOTE The sj5000 has four clearly visible and identifiable emergency stop 
buttons, two on the front of the machine and two on the back. To activate 
these buttons, push in once on the red pushbutton.
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The Emergency stop circuit has the following attributes 
associated with it:

• During an E-Stop, power is removed from all motors 
including conveyors and XY Table. The only exception is that 
turning the maintenance key switch to the “on” position 
re-enables power to the clamping motors. This allows the 
clamping motors to be operated for engineering tests, 
troubleshooting or calibration. 

• E-Stop overrides all modes of operation within the SJ5000 
machine.

• When power is removed from the system, the E-Stop is 
activated automatically and must be reset on powering the 
machine back up. 

There are two ways to reset the E-stop. If the system 
software is running, click Okay to remove the E-stop 
condition. If the system software is not running, press the 
blue ES RESET button on the switch plate. In either case, you 
must first fix the condition that caused the E-stop by either 
closing the front door or pulling the E-stop button out.

Front Switch Panel - sj5000

• On startup, NO uncontrolled motion can occur.
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• The E-stop circuit has two channels, both of which go 
through all four E-stop switches and the front door switch. If 
either channel of the E-stop circuit is activated, an E-stop 
condition will result, and no motive power to the gantry or 
conveyor will be applied.

• Resetting the E-stop circuit can only happen when both 
safety channels are closed.

• In maintenance mode the user is permitted to operate the 
clamping mechanism, as described above.

Earth Bonding
All external metal surfaces are mechanically and electrically 
bonded to the machine earth point. 

The bonding wire used is identified by its green and yellow 
insulation. 

PC Safety
The PC's motherboard contains a lithium battery: CR2032 3V. 

See explanation of warning labels.

CAUTION Never remove or cut these wires. If you find a cut or damaged 
connection, do not operate the machine and inform a suitable 
qualified person as soon as possible.

WARNING THIS MACHINE MUST ALWAYS BE EARTHED WHILE IN USE.

CAUTION Dangerous voltages may exist in the PC after the electrical 
supply has been disconnected.

There is a danger of explosion if the battery is incorrectly 
replaced. Replace only with the same or equivalent type 
recommended by the manufacturer.

Dispose of used batteries according to manufacturer 
instructions.
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1 Safety and Regulatory Information

Physical Safety

Protective Guards
This machine is fitted with a set of protective guards that fully 
enclose any moving and electrical mechanisms that may harm 
you during normal use. Under no circumstances should these 
guards be removed.

Pinch Hazards
The machine is fitted with safety side panels on the left and 
right hand sides of the platform. These panels protect the user 
from electrical and mechanical hazards within the work area. 
The user is to be aware of potential pinch hazards situated at 
the conveyor entry and exit openings.

To prevent pinch hazards, it is recommended to add additional 
guards or covers preventing access to the conveyor entry and 
exit openings. These guards could be preventive guards or 
conveyors.

WARNING DO NOT OPERATE THE MACHINE WHILE ANY OF THE SAFETY 
GUARDS ARE OPEN, LOOSE, DAMAGED OR MISSING. THIS 
INCLUDES ACCESS PANELS TO THE PC. THE PROTECTION 
PROVIDED MAY BE IMPAIRED IF IT IS NOT USED IN THE 
CORRECT MANNER.
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Machine Stability

Falling Objects

WARNING Moving parts at the conveyor Entry and Exit openings situated at 
the sides of the machine. These can cause finger and hand 
damage. No attempt should be made to operate the machine 
while personnel are working in these areas. E-stop the machine 
before placing fingers or hands in these areas. It should be 
additionally noted that Agilent recommends that boards should 
only enter or exit the sj5000 on a conveyor - not via hand loading.

CAUTION This machine weighs approximately 750 kg, and has a low 
center of gravity.

Do not attempt to lift or tip the machine at either end or side, as 
you could damage both the machine and injured yourself. Do 
not even attempt this with the help of others.

CAUTION Do not store boards, equipment, stencils, or other material on 
top of the machine.
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System Warning/Caution Labels

The following are a list of warnings and their associated 
explanation.

Table 1-2 Safety Symbols 

Safety symbols Explanation

Warning electrical danger.
Label located on both left and right side panels also on right rear door to indicate High Voltage 
within.

General warning label.
Located inside PC at the lithium battery.

This indicates you must read the manual before operating the machine. 
Label located on front right side of the hood.

Moving parts at the conveyor Entry and Exit openings (for the Board) at the sides of the machine, 
which could cause finger and hand damage.

230 Volts warning labels 
Location:

• PC 
• Motor Controller
• Transformer Cover
• Top of front Electrical Box
• Main Terminal Trunking Cover 
• Main filter

Warning that hands could be crushed from below. Location 
• Top center of rear panel
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Regulatory Markings
Markings on the system, in manuals and on instruments provide 
information about compliance with international regulations. 
Table 1-3 defines the markings you may find in a manual or on 
an instrument.

Table 1-3    Regulatory Markings

Warning to mind your head.
Label located on the front left and right sides of hood.

Warning that maintenance switch is in ON position. 
The pneumatic air pressure is actuated.
Using the maintenance GUI, the stops and clamps can be operated; therefore, be caution as pinch 
points around clamps can cause injury.

Warning of high voltage. 
Location: 

• Main Filter 
• Main Terminal Trunking

Table 1-2 Safety Symbols (continued)

Safety symbols Explanation

Regulatory markings

The CE mark is a registered trademark of the European Community. This CE mark shows that the 
product complies with all the relevant European Legal Directives.

The TUV mark is a registered trademark of the Technischer Uberwachungs-Verein. A TUV mark 
with the indicators "C" and "US" means that the product is certified for both the U.S. and 
Canadian markets, to the applicable American and Canadian standards.
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Electrostatic Discharge (ESD) Precautions

Static electricity is destructive to your production process and 
the Agilent U1840A Medalist sj5000. Careless handling and poor 
site planning can cause system reliability problems and reduce 
your product yield. The system may not be as easily damaged as 
the modules you will be testing, but good anti-static planning 
will help ensure high reliability. 

The ESD symbol below indicates areas where ESD caution must 
be exercised. This is to prevent damage to instruments and/or 
test disruption.

The C-tick mark is a registered trademark of the Spectrum Management Agency of Australia. This 
signifies compliance with the Australia EMC Framework regulations under the terms of the Radio 
Communication Act of 1992.

This text indicates that the ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme à la norme NMB-001 du Canada.

This instrument complies with the WEEE Directive (2002/96/EC) marking requirement. This 
affixed product label indicates that you must not discard this electrical/electronic product in 
domestic household waste.

ESD Symbol
Caution: Static Sensitive. 
Electrostatic discharge in this area may cause equipment damage or test 
disruption.
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While not an exhaustive list of anti-static precautions, Table 1-4 
shows suggestions to consider as you plan your system area:

Table 1-4    Suggested Anti-Static Solutions for Site Planning

Precaution Suggested Solution

Anti-static flooring Plan to use an anti-static floor 
covering or mats.

Grounding straps Plan for foot straps in conjunction 
with anti-static flooring and wrist 
straps for system operators.

CAUTION The system test rack is secured to the pallet of the shipping crate 
and wrapped with a plastic wrap. Do not move the crate or the test 
rack and pallet to a static sensitive area until you have removed the 
plastic wrap from the test rack. 
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End of Life: Waste Electrical and Electronic Equipment (WEEE) Directive 
2002/96/EC

This product complies with the WEEE Directive (2002/96/EC) 
marking requirement. The affixed product label (see below) 
indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category:

With reference to the equipment types in the WEEE directive 
Annex 1, this product is classified as a “Monitoring and Control 
Instrumentation” product.

Do not dispose in domestic household waste

To return unwanted products, contact your local Agilent office, 
or see:

http://www.agilent.com/environment/product 

for more information.
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The Medalist sj5000 is designed to accurately measure the 
position and properties of each placed component on a Printed 
Circuit Board (PCB). Through measurements, the sj5000 can 
detect a wide variety of placement/printing defects. The sj5000 
is the latest product in the evolution of the Medalist sj family.
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2 Introduction to the Medalist sj5000

Advantages of the Medalist sj5000

Best in Class AOI

The sj5000 is the latest evolution in Automated Optical 
Inspection (AOI) technology for the electronics manufacturing 
industry.

The sj5000 has been designed as a truly flexible ‘best-in-class’ 
AOI solution, to measure and characterize components at 
multiple positions along the SMT manufacturing line. it can be 
configured for Solder Joint Analysis (post-reflow).

Measurement Performance

The sj5000 delivers industry recognized best-in-class 
measurement performance. Using high resolution imaging 
hardware and precision XY gantry, the sj5000 simultaneously 
delivers fast inspection speeds and full 01005 component 
inspection capability.

Fault Coverage

The sj5000 deploys MonoColour, Agilent’s unique sequential 
color imaging technique. This technology allows the AOI system 
to build a color image by combining a sequence of monochrome 
images of the PCB when illuminated with light of different red, 
green and blue colors.

MonoColour allows the AOI system to benefit from the power of 
full color image processing, while utilizing the highest 
resolution and highest speed monochrome camera technology. 
It delivers full color RGB images, which allows for greater 
differentiation of components from substrate, than with black 
and white systems.

Agilent’s MonoColour technology allows the sj5000 to easily 
distinguish SMT component features by unlocking the full range 
of color depth that is available to the human eye.

In addition to color technology, the sj5000 deploys an innovative 
domed lighting head consisting of light emitting diodes (LEDs) 
from multiple angles. This allows pseudo three-dimensional 
information to be extracted from solder joints. Color 3D joint 
profiling is the most powerful technique used in the AOI 
industry for solder joint inspection, and it provides the best 
fault coverage.
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Benefits of MonoColour Technology

MonoColour technology provides the following benefits:

• Improved algorithm performance and reliability.

• Lower false fail and false accept rates.

• Color component inspection.

• Best detection capability in industry while maintaining 
excellent accuracy and GR&R results.

• Easier program setup and maintenance.

• Easier program portability from system to system.

Speed and Performance

For any given speed, the sj5000 offers the highest resolution, 
providing lower false call rates and maximum error detection.

By utilizing the latest camera technology, high image acquisition 
speeds are achieved. The distortion free lens is complemented 
by a high precision XY gantry on which the camera/lighting 
assembly is mounted. By clamping the PCB in the machine 
while it is being inspected the sj5000 delivers highly accurate 
and repeatable results.

Post-Reflow Inspection

The sj5000 performs fast and efficient post-reflow inspection 
for components and solder joints. The proprietary vision 
software reliably determines a range of errors including missing 
or offset components, polarity and solder joint related defects.

Post-reflow inspection has the following benefits:

• Removes the subjectivity of visual inspection.

• Reduces repair costs.

• Improves ICT first pass yield.

• Decreases the time taken to debug complex pre-reflow 
process problems.
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Camera Navigation

Coordinate System

The sj5000 coordinate system is the same as what you see 
through the camera view. For example, if you press the up arrow 
on the keyboard, the camera view moves up on the screen 
(+Y axis). If you press the right arrow key, the camera view 
moves right on the screen (+X axis).

Moving the XY Table

Press an arrow key on the keyboard to move the XY table by 
2,500 microns in the indicated direction. 

You can also use the arrow keys on the numeric keypad (that is, 
the keys 2, 4, 6, and 8). Press once to move the XY table by 250 
microns in the indicated direction.
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Parts of the Medalist sj5000

System Overview
The Medalist sj5000 (Figure 2-1) is constructed from a rigid 
welded base frame which gives stability and support to the XY 
gantry robot and houses the electrical controls of the machine.

• The PC is behind the front access door.

• The gantry motor amplifiers are located at the rear of the 
system in the control panel. The standard sj5000 has two 
amplifiers for the X and Y axes. 

• Connections for two SMEMA cables and an Ethernet cable 
are provided at the rear of the system. These are located on 
the right side of the control panel.

• The electrical mains inlet cable is supplied through a cut-out 
in the machine base-plate, which is accessible from the 
control panel.

Figure 2-1 Medalist sj5000
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Front View

Figure 2-2 Front view of the sj5000

E-Stop button

PC access

Switch plate

Front access door

E-Stop button
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Switch Plate

The switch plate is located on the left side of the sj5000, behind 
the monitor. A cable (p/n 5186-6312) is connected to the back 
and fed to the control panel where it is terminated at XB5 (see 
the Electrical Drawing document for details).

Figure 2-3 Switch plate

Table 2-1    Controls on the switch plate

Item Description

START switch The AC power control switch for the whole system 
after the mains isolator and residual current circuit 
beaker (RCCB).

RUN light The ON indicator light for the START switch.

ES RESET button Resets the safety relay after any E-Stop button is 
pressed or the front access door is opened. Pull out all 
E-Stop buttons and close the front access door before 
resetting the E-Stop circuit.

RAIL 1 INSP/PASS 
switch

Activates the pass-through functionality on rail 1. This 
allows the board to pass through the sj5000 without 
being inspected. The default setting is Insp.

RAIL 2 INSP/PASS 
switch

Does the same with the rail 2 conveyor. This is only 
present on a dual rail sj5000. (Figure 2-1 shows a 
single rail machine with only one conveyor fitted.)
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Front Electrical Interface Module

The front electrical interface module is the electrical junction 
where the conveyor sensors are terminated and interfaced with 
cable 5186-6300. The cable is in turn fed through the base of the 
machine to the control panel and terminated at XB1 on the 
terminal rail. See the Electrical Drawing document for the pin 
number reference.

AWA buttons Allow you to manually adjust the distance between 
the conveyor rails. The top white button narrows the 
distance between the rails and the bottom black 
button widens it. For more information, see “Manual 
Width Adjust”.

PLC RESET button Resets the PLC.

MAINT. SWITCH Allows you operate the board clamps and stops in an 
E-Stop condition.

Figure 2-4 Front electrical interface module

Table 2-1    Controls on the switch plate

Item Description
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Rear View

Figure 2-5 Rear view of the sj5000
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Control Panel

The rear of the base frame houses the majority of the system 
electrical controls. The control panel is secured behind the rear 
access panel, which is lockable.

Figure 2-6 shows the main electrical controls on the control 
panel. For more details, refer to the Electrical Drawing 
document.

NOTE The rear access panel cannot be opened with the mains isolator in the ON 
position.

Figure 2-6 Main electrical controls
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Conveyor
The following diagrams show the motor and sensor locations for 
the conveyor.

Figure 2-7 Right side of the conveyor
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Figure 2-8 Rear of the conveyor
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Power and Communications

Electrical Power
Table Table A-3 in the appendix lists the power specifications 
for the sj5000. 

The equipment must be installed according to the applicable 
national wiring code (NEC) and all applicable local regulations.

• The main incoming protected earth must be terminated at 
the earth terminal. 

• The earth link wire must have a minimum cross-sectional 
area of 4 mm² (or 10 AWG).

• An uninterruptible power supply (UPS) is optional. Ensure 
that the input voltage indicated on the UPS is same as the 
supply voltage.

WARNING All system sub-circuits are 100–120 VAC and 200–240 VAC. Only 
connect equipment rated to this voltage to the system.

WARNING MAINS VOLTAGE DEPENDS ON THE UPS USED. BEFORE 
CONNECTING TO THE MAINS, ENSURE MAINS VOLTAGE IS THE 
SAME AS THE UPS INPUT VOLTAGE
100–120 V or 200–240 V
DETAILS ON MACHINE PLATE
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Communications

SMEMA Communications

A SMEMA standard is used for the machine-to-machine 
electrical interface, which controls the proper sequencing of 
boards. Figure 2-9 shows the wiring connection; refer to the 
Electrical Drawing document for more details.

SMEMA specifies two signal lines: ‘Machine Not Busy’ and 
‘Board Available’ to indicate when a machine can receive a 
board and when it is ready to release a board. 

Signals are communicated between machines via the 14-pin 
SMEMA connector. The ‘Machine Not Busy’ uses pins 1 and 2 
and the ‘Board Available’ signals uses pins 3 and 4. 

The output signals to downstream machines are the ‘Good 
Board’ signal for pins 3 and 4 and ‘Bad Board’ signal for pins 3 
and 5.

In Figure 2-9, boards are transferred from machine A to B and 
from B to C. Machine B is not busy as its pins 1 and 2 are open. 
Machine A has no board available as its pins 3 and 4 are open.

• If machine A did have a board available for transfer, the 
board would trip its Exit sensor and the machine would close 
contact between pins 3 and 4. This would give the signal to 
machine B that there is a board available.

• If machine B were processing a board, it would close the 
contact between pins 1 and 2 to give the ‘Machine Busy’ 
signal to machine A.

Figure 2-9 Pins 1 to 4 of SMEMA Connector

NOTE Board transfer only occurs when machine A has a board available 
(contact closed) and machine B is not busy (contact closed).
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SMEMA Connections

The SMEMA interface ports are located inside the control panel 
of the sj5000. The sj5000 comes equipped with two SMEMA 
cables for each conveyor line to connect to equipment upstream 
and downstream.

• The upstream cable (p/n 5186-0614) must be connected to 
the SMEMA UP connector.

• The downstream cable (p/n 5186-0615) is connected to the 
SMEMA DOWN connector.

These cables need to be routed through the cut-out at the base 
of the system.

The upstream and downstream connections must be made for 
the system to function correctly while operating single or dual 
lane.

Network Connection (Optional)

If the networking option is included with your system, an RJ45 
female connector is provided in the control panel for connecting 
the sj5000 to a network. 

Contact your system administrator for details of connecting the 
sj5000 to the network.
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Serial Connection

Serial ports are provided for connecting barcode readers. They 
are located inside the sj5000 at the rear top left corner.
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Checking the Facilities and Tools

Ensure that the system environment meets the specifications 
(see “Environmental Conditions”). Refer to the Site 
Preparation Manual for details. 

Required Tools

The following tools are required for sj5000 installation:

• Set of metric hexagonal Allen keys: 1.5, 2, 2.5, 3, 4, 4.5, 5, 5.5, 
6, 7, 8, 9, and 10

• T30 TORX key

• Set of insulated slotted screwdrivers: 2.8, 4.0, 5.5, and 6.5

• Pistol grease gun

• THK AFB+70 (lithium based) grease

• 25 mm/46 mm spanner

Unpacking the sj5000

The sj5000 is shipped on a wooden pallet with a cardboard box 
enclosing the system.

Unpack the sj5000 as follows:

1 Check all the Tip’n’tell indicators and shock sensors. 
Figure 3-1 shows their locations on the box. Refer to the 
details on the indicators to verify pass or failure. 

If any of them are activated, the sj5000 may have a problem. 
Do not remove anything and report the situation to Agilent. 

2 Remove the straps holding the cardboard box in place.

3 Remove the cardboard edge protectors.

4 Remove the top of the cardboard box, and lift the remainder 
of the box away from the wooden pallet.

5 Undo the ratchet straps that hold the sj5000 to the wooden 
pallet. 

The sj5000 can now be lifted off the pallet using a forklift and 
moved into position. See “Moving the sj5000” for important 
notes and instructions.
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Figure 3-1 Locations of indicators and sensors
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Moving the sj5000

When handling the sj5000, bear in mind the following:

• The machine is designed for transportation and handling by 
either a hydraulic pallet truck or forklift.

• The machine is designed to be lifted from any of its four 
sides, however, when inserting the forks of the lifting device 
under the machine, care must be taken to ensure that the 
lower panels are not damaged as a result of poor handling. 

• When lowering the machine from an elevated position the 
lifting device operator must ensure that all sides of the 
machine are clear from obstructions.

Ensure that the correct space is available on the production line 
(see the Site Preparation Manual) before lifting and moving the 
sj5000 into position.

It is important that the machine is aligned so that its fixed 
conveyor rail is in-line with the fixed rails of the input and 
output conveyors.

1 Disconnect the power cord.

2 Secure the X and Y axis with shipping clamps.

3 Use a hand truck to lift the machine approximately one inch.

4 Remove the packaged parts from under the machine.

5 Turn the four adjustable feet so that they go approximately 
two inches into the machine.

6 Carefully move the machine to the desired location.

7 Slowly lower the machine so that the feet are about one inch 
from the floor.

8 Turn the four adjustable feet out they touch the floor, and 
then adjust the height until the system conveyor height 
matches that of the input and output conveyors.

9 Once the correct height has been reached, tighten the feet 
locking nuts with the 46 mm spanner.

10 Ensure that all four feet are solidly on the ground.

11 Lower and remove the hand truck.

NOTE The lifting device used to move the sj5000 must be rated to lift and carry a 
2 tonne load. The forks of the lifting device should be a minimum of 1.0 m 
in length with a minimum fork spacing of 0.5 m (the inside gap between 
the forks).
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12 Remove the shipping clamps before operating the gantry.

NOTE These steps must be followed every time the machine is lifted, regardless 
of whether it is moved from its location.

WARNING If the machine is being used outside of the production line, a 
conveyor must be fitted both upstream and downstream for safety 
reasons.

WARNING The machine must never be raised, lowered, or moved while 
electrical power is connected.
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Adjusting the Height and Leveling the sj5000

Adjusting the Height 

The four adjustable feet are used to vary the height of the 
sj5000. As described in “Moving the sj5000”, the height must be 
adjusted so that the system conveyor height matches that of the 
input and output conveyors.

Leveling the sj5000

After adjusting the height, level the machine as follows: 

1 Loosen the feet locking nuts.

2 Place the level gauge on the X rail and adjust the feet until 
the machine is level.

3 Do the same way for the Y rail.

4 Ensure the final height is same as the input and output 
conveyors.

5 Once the correct level has been achieved, tighten the feet 
locking nuts.
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Mounting the Lighting Tower

The lighting tower is mounted on the roof of the sj5000.

1 Feed the cable through the mounting hole on the roof and fit 
the light tower with the three screws provided and a 2.5 mm 
Allen key.

2 Ensure that the 22 mm nut is tightened against the round 
mounting plate. 

3 Fit the two connectors together inside the machine. 

Cable from lighting
tower
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Installing the Keyboard and Monitor

1 Remove the four mounting screws at the front left of the 
machine below the switch plate.

2 Align the monitor/keyboard mount arm with the mounting 
plate on the machine and tighten the screws.

3 Place the mounting pole through the keyboard tray mount 
clamp and then into the monitor/keyboard mount arm. 

4 Tighten the keyboard tray in place. 

5 Secure the mounting pole by tightening the screw in front of 
the mount arm.

6 Remove the four inner screws from the back of the monitor. 
Align the holes with the monitor mounting plate, then insert 
and tighten the four screws. 

7 Place the keyboard and mouse on the keyboard tray.

Monitor
mount

Mounting
pole Keyboard

mount

Monitor/
keyboard
mount arm
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Next, connect the cables for the monitor, keyboard, and mouse.

1 Connect the monitor power cable and monitor signal cable to 
the monitor and secure them in place with the cable ties 
provided. 

Do not secure the cables too tightly. Ensure there is enough 
slack so that the monitor/keyboard arm can be adjusted 
without straining the cables. 

2 Feed the monitor power, monitor signal, mouse, keyboard, 
and keyboard earth cables along the mount arm to the inside 
of the system.

3 Open the front access door and connect the cables to the 
corresponding cables inside the machine.
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Connecting the Mains Cable

The mains cable uses US or EU color coding depending on the 
option purchased and no connector is provided. The connector 
to be used will depend on the requirements of the factory in 
which the sj5000 is being installed. 

1 Route the mains cable from the mains isolator following the 
cleats provided. 

2 Feed the cable through the slot in the base of the machine.

3 Install the connector and plug it into the factory mains 
supply.

WARNING The mains connection should only be done by qualified personnel.

Mains cable

Mains
cable
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Earth Cable Connection

The earth cable is connected to the earth terminal block as 
shown below.

WARNING The mains connection should only be done by qualified personnel.
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Before Powering Up

Before turning the Medalist sj5000 on at the mains isolator, do 
the following:

1 Make sure the mains isolator is switched off, then remove the 
rear access panel.

2 Measure the voltage between live (phase 1) and neutral 
(phase 2) at the mains isolator. The voltage should be 100 to 
120 VAC or 200 V to 240 VAC.

3 Ensure the system is correctly earthed.

Now you can power up the sj5000 as described in the following 
pages. Refer to Figure 4-1 for the locations of the switches and 
buttons to use.

Figure 4-1 Controls on the switch plate at the front of the machine
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Powering Up the sj5000 for the First Time

When powering up the sj5000 for the first time, carry out the 
following steps:

1 Ensure that electrical power has been connected by a 
suitably qualified person.

2 Ensure that the mains isolator is in the OFF position. 

3 Switch on all other MCBs.

4 Verify that all circuit breakers are on.

5 Measure the input voltage and ensure that it is the rated 
voltage of the machine.

6 Ensure that the XY table is free to move over its entire 
envelope before continuing. You can manually move it 
around its enclosure.

7 Ensure that the conveyor is free from obstruction.

8 Ensure that the MAINT. SWITCH is in the O position (off).

9 Ensure that the front access door is fully closed. Pull out all 
the E-Stop buttons before continuing.

10 Ensure the rear access panel is locked in position. 

11 Turn on the sj5000 at the mains isolator.

12 Turn the START key switch to the ON position. 

13 Ensure that the green RUN light is lit. If the RUN light is not 
lit, check the input power.

14 Ensure the RAIL 1 switch is set to INSP (inspect).

15 Turn on the UPS (if installed) and turn on the monitor.

16 Reset the E-Stop circuit by pressing the ES RESET button.

17 Turn on the PC.
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Powering Up From the Mains Off Position

To power up the sj5000 from the mains off position, do the 
following:

1 Ensure that the START key switch at the front of the machine 
and the mains isolator are in the OFF position. 

2 Ensure that the XY table is free to move over its entire 
envelope before continuing. Remove any tools or equipment 
that may hinder the table as it moves inside the enclosure.

3 Ensure that the rear access panel is locked in position and 
turn the mains isolator to the ON position.

4 Ensure that the MAINT. SWITCH is in the O position (off).

5 Ensure that the front access door is closed.

6 Turn the START key switch to the ON position. Ensure that 
the green RUN light is lit. If the RUN light is not lit, check the 
input power. 

7 Turn on the UPS (if installed) and turn on the monitor.

8 Ensure that all four of the E-Stop buttons are pulled out. 

9 Turn on the PC.

10 Press the ES RESET button. 
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Powering Up to Restore From an Emergency Stop

To power up the sj5000 to restore from an emergency stop, 
perform the following:

1 Ensure that the front access door is fully closed.

2 Pull out all the E-Stop buttons.

3 Press the ES RESET switch.

4 If the sj5000 software is running, also click the Okay button in 
the E-Stop alarm window.

Machine Cycle

The sequence of events during a board load—inspect—eject 
cycle is as follows:

• The upstream machine provides a ‘Board Available’ signal to 
the sj5000 via the SMEMA interface.

• When ready to accept a board, the sj5000 gives the upstream 
machine a ‘Machine Not Busy’ signal through SMEMA.

• If a hardware barcode reader is used, it is normally triggered 
at the same time as the ‘Machine Not Busy’ signal. It is 
possible to configure the system to trigger the reader first 
and await a good read before sending ‘Machine Not Busy’ — 
this would typically be used when integrating with a factory 
management system. 

• When both ‘Board Available’ and ‘Machine Not Busy’ are 
true, the upstream machine passes a board to the sj5000.

• Once the board is inside (that is, seen by the Entry sensor) 
the sj5000 disables the ‘Machine Not Busy’ signal to the 
upstream machine.

• The board stops are activated once the conveyor starts to 
move (as a result of a board entering the machine).

• When the board is detected by the In-Position sensor.

• The conveyor slows down and halts such that the board is 
resting against the board stops.

• The board is clamped in position.

• When the clamps are successfully raised, the Programmable 
Logic Controller (PLC) gives a board present signal to the PC.

• The board is inspected. 

• When inspection is complete, the PC informs the PLC that 
the board has passed or failed inspection.
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• The board is then released:

• The clamps and stops are lowered.

• The board drops smoothly onto the conveyor and the 
conveyor starts running.

• The board transfers to the Exit sensor. 

• The sj5000 signals the inspection result to the downstream 
machine via SMEMA (pins 3 and 4 closed = Good Board 
Available, 3 and 5 closed = Bad Board Available)

• When the sj5000 gets a ‘Machine Not Busy’ signal from the 
downstream machine, the conveyor is driven until the board 
exits the machine and the cycle begins again.
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This chapter describes how to manually and automatically 
change the distance between the conveyor rails. The sj5000 
allows the operator to adjust the conveyor width without 
opening the front door of the machine.
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Sensors and Flags

Mounted on the conveyor are three sensors used to control the 
Auto Width Adjust (AWA). These sensors are used to detect the 
minimum width, maximum width, and rail alignment. The 
sensors are identified as follows:

• Left minimum width (Left Min) sensor

• Right minimum width (Right Min) sensor

• Left maximum width (Left Max) sensor

Each of the three sensors has a corresponding flag mounted on 
the moving rail of the conveyor.

The sensors are installed so that each sensor is triggered when 
the rails reach a maximum or minimum distance apart (this can 
vary between single and dual lane conveyors).

• Minimum width  
The default sj5000 minimum rail distance is 50 mm. 
However, if a user adjusts the edge clearance, this may vary.

• Maximum width  
The maximum width for all conveyors is 510 mm (single 
lane). The Left Max is installed so that it triggers when the 
rails are 510 mm apart (approximately 2 mm less than the 
maximum travel distance).

Figure 5-1 Sensors and flags on the conveyor
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Manual Width Adjust

You can manually adjust the distance between the conveyor 
rails using the AWA buttons on the switch plate at the front of 
the sj5000.

1 Ensure there are no boards in the sj5000.

2 Ensure the E-Stop circuit has been reset.

3 To narrow the distance between the rails, press the top white 
button (AWA OUT). Hold the button for at least one second to 
activate the movement. 

4 To widen the distance between the rails, press the bottom 
black button (AWA OUT). Hold the button for at least one 
second to activate the movement. 

5 When finished, press the PLC RESET button. 

Figure 5-2 AWA IN/OUT buttons on the switch plate
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Auto Width Adjust

You can manually adjust the distance between the conveyor 
rails using the sj5000 software.

1 Ensure there are no boards in the sj5000.

2 Launch the sj5000 software in Engineer mode.

3 In the main toolbar click the Tools button.

4 Under Category, click the Auto Width Adjust folder. 

5 You will be reminded to remove all boards from the sj5000. 
Click Yes to continue. (You will not be able to continue if any 
boards remain in the machine.) 

6 In the Auto Width Adjust window (Figure 5-3), click the Jog 
Out and Jog In buttons to adjust the distance between the 
conveyor rails.

The Auto Width Adjust Window
To access the Auto Width Adjust tools, from the Tools menu 
click the Auto Width Adjust folder.

Figure 5-3 Auto Width Adjust window

Table 5-1    Tools for Auto Width Adjust

Field/Function Description

Min Width Displays the minimum conveyor width allowed. If you enter 
a Required Width that is less than the minimum, then this 
value will be used instead.

Max Width Displays the maximum conveyor width allowed. If you 
enter a Required Width that is greater than the maximum, 
then this value will be used instead.
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Current Width Displays the current distance between the conveyor rails. 
If the conveyor rails are moving, the message ‘Axis 
Moving’ is displayed. 

Required Width Lets you specify the desired distance between the 
conveyor rails. Specify a value between the minimum and 
maximum widths.

Move Click Move to move the conveyor rails to the specified 
distance apart. 

Stop Click Stop to abort a move operation. The conveyor rails 
will stop moving and the Current Width shows the current 
distance between the rails.
The move operation is also aborted when an E-Stop button 
is pressed. 

Jog Out/Jog In Click Jog Out/Jog In to jog the conveyor rails out or in. 
Each click moves the rails by the selected pulse increment: 
0.5 mm, 1 mm, or 10 mm.
Hold down the Jog Out/Jog In buttons for continuous 
movement of the conveyor rails.

AWA PLX Control Select this option to enable automatic adjustment of the 
conveyor width based on the width setting in the PLX file 
for a board. 
To set the width, insert the following line in the PLX file:  
w <microns> 
For example, w 125000 sets the width to 125000 microns 
or 125 mm.

Home Returns the conveyor rails to a known position and 
ensures that they stay parallel.
This should be used if the machine has been switched off 
for a while or if any work carried out inside the machine 
has caused the moving conveyor rail position to change.

Calibrate Calibrates the automatic width adjust functionality. This 
will set the conveyor width and also align the conveyor 
rails. See “Calibration”.

Table 5-1    Tools for Auto Width Adjust

Field/Function Description
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Calibration

When you click Calibrate, instructions for calibration appear in 
the following window.

NOTE Make sure the rails are parallel and the distance between the fixed and 
moving rails is 70 mm. The Minimum Width Position must be less than 
the Left Shuttle Width.



6-1

Agilent U1840A Medalist sj5000 Automated Optical Inspection System
Hardware Manual

Agilent Technologies

6
Auto Width Adjust Conveyor Setup
Linear Mechanical Setup    6-2
AWA Setup and Calibration    6-7
General Conveyor Checks    6-12
Board Sensor Checks    6-13
AWA Conveyor Component Alignment    6-15
Clamp Home Sensor Adjustment    6-16
Conveyor Speed Adjustment    6-18
Changing Conveyor Direction    6-19



6-2 Agilent U1840A Medalist sj5000 Hardware Manual

6 Auto Width Adjust Conveyor Setup

Linear Mechanical Setup

The tools required for this check are a 2 mm Allen key and an 
engineers steel ruler.

In order to achieve mechanical accuracy with the AWA 
conveyor, carry out the following setup check and make the 
necessary adjustments.

1 Use the steel ruler to measure the distance from the inside of 
the linear rail to the outside of the black lip where the outer 
clamp edge ends. This distance must be less than or equal to 
4.75 mm along the entire the length of the rail as shown 
below. 

2 If the measurement exceeds 4.75 mm, proceed with the 
mechanical setup described in “Conveyor Edge Clearance 
Adjustment”.

3 If the measurement is acceptable (less than or equal to 
4.75 mm), proceed to “AWA Mechanical Setup”. 
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Conveyor Edge Clearance Adjustment
If the conveyor edge clearance is greater than the SMEMA 
standard of 4.75 mm or it is to be set to something other than 
the SMEMA standard, follow the procedure below to adjust it. 

Note that the preferred fixed position of the linear rails is at 
3.5 mm but the clearance can be increased to up to 3.75 mm. 
Also note that the maximum clearance is 4.75 mm (this includes 
1 mm for the clamp). If trying to reduce the edge clearance any 
further, consider carefully how much of the belt is left to carry 
the PCB. Care should also be taken to set the top and bottom 
side edge clearances such that they do not hinder board transfer 
and clamping.

3.5 mm

Belt Clamp

NOTE It is assumed that the clamp is 1 mm thick. When taking measurements 
the fixed straight edge of the conveyor rail is used for accuracy. When 
re-checking the set distance, the clamp thickness is taken into account to 
verify that the edge clearance conforms to the SMEMA standard.
The following procedure illustrates how to set a clearance of 3.5 mm. The 
steps are the same when setting other clearances.
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1 Loosen the screws along the length of the finger clamp using 
a 2 mm Allen key. Use care when loosening the screws as 
they may be very tight. Remove the finger clamp.

2 Measure the distance from the inside of the linear rail to the 
outside of the black lip where the belt edge ends. When 
setting the clearance to 3.5 mm, this distance should be 
2.5 mm. 

3 If necessary, loosen the screws along the linear rail. Use care 
when loosening the screws as they may be very tight. It may 
help to add a drop of oil or anti seizure solution. Adjust the 
distance to 2.5 mm along the whole length of the conveyor. 

4 When you are satisfied that the whole rail is set at the correct 
distance, tighten all the screws along the linear rail.

5 Replace the finger clamp and ensure that it is aligned with 
the board clamps.

6 Place the finger clamp back on top of the linear rail and then 
align its front edge with the edge of the board clamps. Move 

Loosen all screws along the
length of the finger clamp

on top rail

2.5 mm distance set
along whole length
of rail
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the clamp assembly up by hand so the edges meet, making 
sure the clamps are parallel to each other. 

7 Tighten all the machine screws along the finger clamp.

8 Re-check the full edge clearance by measuring the distance 
from the inside of the linear rail to the outside edge of the 
clamp. 

9 Ensure that all clamps are straight, parallel and free moving. 
The distance must not exceed 4.75 mm (SMEMA). (This 
distance is set to 3.5 mm when the sj5000 is manufactured.) 

Outer edge of finger
clamp against outer
edge of clamp blade

3.5 mm

Belt Clamp
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AWA Mechanical Setup
To achieve accuracy when the conveyor homes and moves to its 
desired width, check the position of the maximum and 
minimum sensors and set them up according to the factory 
default.

Figure 6-1 shows the sensor distances to be set. Use a steel ruler 
to measure from the base to the sensor edge. If the 
measurements are different from those shown, loosen the 
sensor setting screw, adjust the sensor position, and tighten the 
screw to secure the sensor.

Figure 6-1 Sensor positions

155 mm

72 mm

Max Sensor Min Sensor

155 mm
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AWA Setup and Calibration

Perform the following steps:

1 Set up the sensors and flags. Refer to “AWA Mechanical 
Setup” for instructions. Also see “Sensors and Flags” for a 
description of the sensors and flags.

2 Ensure that all sensors and I/O are working correctly: 
Trigger each of the AWA sensors individually, using a small 
screwdriver or piece of paper to simulate the sensor 
triggering. You will need another person check the PLC 
inputs on the control panel in the rear of the machine. Verify 
that the PLC input LED turns on and off as you activate and 
deactivate the sensor. 

Auto Width Adjust Calibration
1 Ensure there are no boards in the sj5000.

2 Launch the sj5000 software in Engineer mode.

3 From the Tools menu click the Auto Width Adjust folder.

4 Click Calibrate.

5 Open the front access door. Adjust the rails inwards until 
they can no longer move. (The ball screw housing rubber 
stops will not allow further movement.) 

Input Sensor
01.00 Left Max Sensor
01.01 Left Min Sensor
01.02 Right Min Sensor
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6 Move the rails outwards until the fixed and moving rails are 
50 mm apart and parallel. This is the minimum width and 
should be measured between the inside linear rail on the 
fixed rail and inside the linear rail of the adjustable rail. 
Ensure they are parallel by measuring the rail separation at 
either end of the rails.

7 Adjust the rail outwards by hand until the Left Min sensor is 
not triggered. Then adjust the rail inward by hand until the 
Left Min sensor is triggered. Measure and take note of the 
conveyor width.

8 Adjust the rail inwards by hand until the Right Min sensor is 
triggered. Measure and take note of the conveyor width. 
Make sure that the difference between the Left Min sensor 
getting triggered and the Right Min sensor is approximately 
1 mm. The closer it is to 1 mm, the faster the conveyor will 
calibrate.

9 Now adjust the rails outwards by hand to 70 mm, making 
sure the conveyor rails are parallel at either end.

10 Close the front access door and reset the E-Stop circuit.

11 Enter the measured values noted above for the Left Min 
sensor (Left Sensor Width) and the minimum width. In 
Maximum Width Position, enter 510 mm for a standard 
single rail system and 216 mm for a standard dual rail 
system.
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12 After entering the new values, Click Set Min/Max Width to 
write the new values to the PLC. Then click Ok to start the 
calibration.

During calibration the following message appears.

When calibration is finished, the conveyor will step 30 mm 
off the sensors and then home. 

The conveyor will home. Before homing the PLC will check if 
the rail is on a sensor. If a sensor is triggered then the rail 
will move out 50 mm and then commence homing.

When homing the adjustable rail moves in until it triggers the 
Left Min sensor. It will then look for the Right Min sensor. If 
it is not found the ‘Right Motor Only’ will be switched on and 
adjusted inwards by up to 5 mm. Once the sensor is found, 
the ‘Right Motor Only’ will be switched off, and both motors 
will go to the minimum width position. 

When homed the following is displayed:

If any errors are encountered during calibration or homing, an 
error message will be displayed. Exit the AWA function and 
reset the PLC from the switch plate before attempting the 
calibration process again. 



6-10 Agilent U1840A Medalist sj5000 Hardware Manual

6 Auto Width Adjust Conveyor Setup

Conveyor Width Adjustment
If calibration is successful, proceed with the following: 

• Check using calipers that the distance between the conveyor 
rails is the same as the value in the Current Width field. 

• The conveyor width can now be adjusted: 

• Enter the width required into the Required Width field 
and press Enter.

• Click Move to move the conveyor rail in or out to the 
required width. Every time the AWA is accessed the 
conveyor will automatically home itself for the first move, 
and then move to the required width entered.

If the width entered is below or above the minimum and 
maximum widths respectively, the conveyor will move to 
either the minimum or maximum width depending on the 
value. 

• To stop the conveyor when moving to a specified width, click 
Stop to cancel the move operation.

If any problems occur when the conveyor is attempting to move, 
an error message will be displayed.
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Testing the Move, Stop, and Jog Functions

To test the Move function, follow the instructions below:
1 Enter 200 mm in the Required Width field and click Move.

2 Wait until 200 mm is displayed in Current Width.

3 Using Vernier calipers, check that the width of the conveyor 
is 200 mm ±0.5 mm at both ends.

4 Enter 100 mm into the Required Width field and click Move.

5 Wait until 100 mm is displayed in Current Width.

6 Using Vernier calipers, check that the width of the conveyor 
is 100 mm ±0.5 mm at both ends.

7 Exit the AWA menu, wait 5 seconds, and re-enter the AWA 
menu.

8 Enter 150 mm into the Required Width field. The conveyor 
should first home and then move to 150 mm.

9 Using Vernier calipers, check that the width of the conveyor 
is 150 mm ±0.5 mm at both ends.

To test the Stop function, do the following: 
1 Enter 300 mm in the Required Width field and click Move. 

2 Before the conveyor reaches this width, click Stop. 

3 Using calipers, measure the distance between the two rails 
and check that it corresponds to the value in Current Width. 

To test the Jog function, do the following:
1 Select a step size and click Jog Out or Jog In to jog the 

conveyor rails. 

The value in the Current Width field should increase or 
decrease correspondingly. 

2 Using Vernier calipers, measure the distance between the 
two rails and check that it corresponds to the value in 
Current Width.

3 This test should be run for all three conveyor step sizes, for 
both the Jog Out and Jog In buttons.
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General Conveyor Checks

In order to check the clamps, stops and sensors, access to the 
interior of the machine is required. The MAINT. SWITCH is used 
to enable Maintenance mode for such checks. In Maintenance 
mode, no power or control is given to the gantry or conveyor 
belt motors, to safeguard personnel carrying out maintenance 
and calibration on the system.

1 Remove any boards from the conveyor, and make sure the 
sj5000 software is running.

2 Turn the MAINT. SWITCH clockwise to the ON position and 
push the E-Stop button (the sequence is not important).

3 Open the front access door.

4 In Maintenance mode, use the Up and Down buttons in the 
software to control the movement of the clamps and stops. 
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5 When maintenance is completed, make sure all clamps and 
stops are returned to their down resting positions. 

6 Close the front access door and turn the MAINT. SWITCH 
anticlockwise to the OFF position. The Maintenance window 
will be closed and normal control will be given to the 
machine. 

7 Pull the E-Stop button out to reset the E-Stop circuit.

Board Sensor Checks

Follow this procedure adjust the triggering level for the board 
sensors. 

1 Remove any boards from the conveyor, and make sure the 
sj5000 software is running.

2 Turn the MAINT. SWITCH clockwise to the ON position and 
push the E-Stop button (the sequence is not important).

3 Open the front access door.

4 Locate the Entry sensor. This depends on the conveyor 
direction (left-to-right or right-to-left); it is the first sensor 
the board will encounter.

5 Adjust the Entry sensor anticlockwise to reduce the 
triggering distance or clockwise to increase the distance. 

When the sensor is powered, the green LED will be lit. When 
the sensor is triggered, an amber LED will be lit. 

6 Adjust the screw (shown above) such that the sensor will 
trigger approximately 5 mm above the conveyor height. Make 
the adjustments using a small jewelers screwdriver and a 
PCB to set the distance.

7 Move the gantry by hand over the sensor and ensure that the 
lighting head and gantry do not trigger any of the board 
sensors. 

Adjusting screw
Entry, Exit, and
In-Position sensors
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8 Use the potentiometer at the bottom of the sensor to adjust 
the light to dark trigger.

9 Repeat this procedure for the Exit sensor and the In-Position 
sensor.

10 When finished, push a board over each sensor and check PLC 
input from the control panel.

NOTE Do not move the gantry using the cables assembly.

Input Sensor
00.06
00.07
00.08
01.05
01.06
01.07

Entry Sensor Rail 1
In-Position Sensor Rail 1
Exit Sensor Rail 1
Entry Sensor Rail 2
In-Position Sensor Rail 2
Exit Sensor Rail 2
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AWA Conveyor Component Alignment

In order to achieve smooth operation during stopping and 
clamping, the stopping and clamping mechanism must be 
correctly assembled and aligned. 

Figure 6-2 Clamping mechanism

NOTE The clamp up and down speed is fixed and not adjustable.
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Clamp Home Sensor Adjustment

The Clamp Home sensor has to be adjusted its fit and flatness 
between the board and top finger clamp. Follow the steps below 
to adjust the sensor.

The tools required are:

• Clamping tolerance test board

• 50 μm filler gauge

• Metric Allen keys

The board clamping plate is 510 mm in length. It is important to 
ensure the flatness of the plate along its length when a 
production board is clamped.

1 Activate Maintenance mode and manually insert the test 
board onto the clamping location.

2 Click the clamps Up button in the Maintenance window to 
clamp the board.

3 Insert the 50 μm filler gauge into every clamping tooth that is 
in contact with the board. To pass the test, the filler gauge 
should bend when you try to insert it between each clamping 
tooth and the board. 

4 If the clamping mechanism fails the filler gauge test, adjust 
the Clamp Home sensor to enable the clamp plate to move 
further up and provide a firmer clamp. To do so, loosen the 
sensor screws, push up the sensor slightly and tighten the 
screws.
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Use caution when adjusting the Clamp Home sensor. Setting 
it too high may cause the clamp plate stepper motor CAM to 
overshoot. 

5 Repeat the above steps for all three locations on the clamp 
plate to ensure that they all meet the clamp tolerance 
requirement.
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Conveyor Speed Adjustment

The speed of the conveyor can be adjusted by turning a 
potentiometer (POT) on the PLC. The POT is located behind the 
cover marked Peripheral in the control panel. 

Tune the conveyor speed by using a screwdriver to turn the 
potentiometer.
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Changing Conveyor Direction

To change the conveyor direction from a left-to-right 
configuration to right-to-left configuration, the clamp plates 
need to be dismantled and swapped. The following shows the 
default left-to-right configuration for the clamps.

To change to a right-to-left configuration, follow these steps:

1 Remove 16 screws from the linear block and four screws 
from the motor block as shown above. Then remove the 
clamp plate.

2 Remove the other clamp plate in the same way.

3 Swap the clamp plates. 

4 Place the stopper at the left side as shown. 

5 Replace all the screws. 
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6 Move the clamp plates up firmly against the top finger 
clamps and tight all the screws.

7 Adjust the Clamp Home sensor to ensure the clamps are able 
to home properly (see “Clamp Home Sensor Adjustment”).

Flush against top finger clamp
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Camera Calibration

Camera calibration involves the following tasks:

• Focusing: manual adjustment of the lens so that a sharp clear 
image can be acquired by the camera. See “Focusing the 
Camera”.

• Scaling: using the Auto-scale procedure to automatically 
determine the optical pixel size of the camera sensor. See 
“Auto-Scaling”.

Focusing the Camera
1 Launch the sj5000 software in Engineer mode and load a 

board. 

2 Open the Tools menu by click the Tools button on the main 
toolbar.
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3 Under the Camera folder, click Lighting Controller.

4 Select the lighting mode by clicking the first button in the 
Lighting area. For post-reflow, use Solder Joints which consists 
of the 70 and 60 degree rings.

5 Open the front access door.

6 Drag the E-Stop alarm window to one side so that the camera 
display is visible.

7 Turn the MAINT. SWITCH on the switch plate to the ON 
position.

8 Click on clamps Up in the Maintenance window to clamp the 
board.

9 Once the board is clamped, minimize the Maintenance 
window.

10 Set the camera lens aperture to F-stop 5.6 (see “Setting the 
Lens Aperture”).
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11 Loosen the lens locking clamp.

12 Turn the focus ring on the lens until the board and 
component leads are sharply focused on the screen.

13 When you have a sharp image, clamp the lens and tighten all 
screws associated with the camera. 

14 Turn the MAINT. SWITCH back to the OFF position. This 
automatically closes the Maintenance window. 

15 Close the front access door and clear the E-Stop alarm. 

16 Click Ok on the Focus menu to re-enable the gantry motors.

After the camera has been focused correctly, the system scaling 
must be performed and the lighting calibration should be 
updated (see “Lighting Calibration”).

Figure 7-1 Focus ring on the camera lens
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Setting the Lens Aperture

To set the camera lens aperture to F-stop 5.6, do the following:

1 Unlock the lens aperture. The lock switch is located at the 
side of the aperture window.

2 Turn the aperture size to 5.6 as shown below.

3 Re-lock the lens aperture.
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Auto-Scaling
The purpose of auto-scaling is to ensure an accurate 
determination of pixel size for measurement and for scaling 
inspection algorithms. Once set, camera scaling should not need 
to be adjusted. If a different scaling is required raise or lower 
the camera, re-focus, and then perform auto scaling.

1 Load a board in the sj5000.

2 Pick a fiducial on the board whose presence score is above 
900. (Refer to the Engineering Manual for details on fiducial 
training.)

3 From the Tools menu click the Camera folder.

4 Click Automatic in the Scaling area.

The gantry will start moving in the X and Y directions and 
locate the fiducial for each position it goes to. This allows the 
determination of the physical pixel size of the system.

NOTE Always ensure the camera is well focused before scaling.
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5 When the gantry has stopped moving, from the Tools menu 
click the Interface folder and click the System Information icon.

6 Verify the values for pixel size (19 microns ±1 micron for the 
sj5000) and field of view in the System Information window. 
These may be different for certain applications. 

7 Click Close and then close the Tools menu.
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Raising or Lowering the Camera

1 Loosen the lens locking clamp to allow the camera lens to 
move.

2 Hold the camera and loosen the four screws shown below. 
This allows you to adjust the camera by sliding it up or down 
in the bracket. 

3 Tighten the four screws and the lens locking clamp.
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Lighting Calibration

Lighting calibration sets the current output for each lighting 
ring. It is performed over a gray card, which is used to calibrate 
the illumination evenness. The gray card is manually loaded 
into the sj5000. The system will then:

• Turn each ring on.

• Record the mean gray level intensity over the gray card.

• Compare it to a target mean intensity.

• Adjust the current output to bring the recorded mean as 
close as possible to the target mean. 

The new calculated means are referred to as Achieved Means 
and are displayed in the Calibrated Means column in the 
Lighting Controller window.

The procedures for lighting calibration are described in the 
following sections:

• Lighting Calibration (Manual): for manual calibration

• Auto Calibration: for automatic calibration

• Calibration on Location: at automatic calibration at specific 
location

The calibration functions and lighting information are accessed 
from the Lighting Controller window. For a summary of the 
features, see “The Lighting Controller Window” on page 14.

NOTE Lighting auto-calibration calculates all ring lighting modes available on 
the sj5000.
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Lighting Calibration (Manual)
1 From the Tools menu, click Lighting Controller under the 

Camera folder to display the following window.

A lighting ring is enabled when the check box beside the ring 
name is selected. When a lighting ring is enabled, the 
corresponding current in the mA/4 column is sent to the 
lighting controller. Each lighting ring has a maximum 
current; in addition, the current that may be sent to the 
lighting controller must not exceed 4000 mA.

2 Ensure that the current for each enabled lighting ring is set 
to the correct value and complies with the value set in the 
Targets column. 

To undo changes made to the output values, click Undo.

3 These values also have to be logged by clicking Log.

The camera will then take one image with each bank of LEDs, 
and puts the results in the file Intensity.log, located in the 
C:\Cpi\Log folder.
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4 When changes have been made to the lighting intensities, you 
will be prompted to save the new current values. Click Yes to 
display a summary of the changes made.

5 Click OK.
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Auto Calibration
The auto calibration feature requires the use of a calibration 
plate (optional, not included with the sj5000). Before starting 
the auto calibration process, you must set the location of the 
calibration plate.

1 Ensure that there are no boards in the sj5000.

2 From the Tools menu, click Lighting Controller under the Camera 
folder.

3 Click Set Location.

The system turns the LEDs on and displays the following 
instruction: 

4 Jog the camera as instructed and click Set.
5 Click Yes to confirm.

The system is now ready for lighting auto calibration. 

6 Click Auto Calibration.

The camera automatically moves to the location of the 
calibration plate and calibration will start.

7 You will be informed when the calibration is successfully 
completed. Click OK.

The current outputs for each ring before and after calibration 
are shown. These values area also written to the file 
LightingController.log. 
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Auto calibration results in new calibrated values which are 
saved in CalibratedLightingValues.xml. The values are also 
displayed in the Achieved Targets column in the Lighting 
Controller window.

If any errors occur during calibration, troubleshoot with the 
help of the log file CalibrationResults.log and perform the auto 
calibration again.

Calibration on Location
The following procedure performs automatic calibration at a 
specific location.

1 From the Tools menu, click Lighting Controller under the Camera 
folder.

2 Click Calibrate on Location.

3 Insert the gray card into the sj5000 and jog the camera over 
it. Click Calibrate.

Calibration takes place at the current location. When 
calibration is complete, the new calibrated values are saved 
and also displayed in the Achieved Targets column in the 
Lighting Controller window.
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The Lighting Controller Window
The Lighting Controller window (Figure 7-2) is accessed 
through the Tools menu (click Lighting Controller under the Camera 
folder).

The Lighting Controller window shows the following 
information:

• Name of the lighting controller (SLC-800 in this example) 

• Lighting rings information 
A list of lighting rings is displayed. To activate a lighting ring, 
select the check box next to its name. The following details 
are shown for each ring: 

• mA/4: When a lighting ring is enabled, this current is sent 
to the lighting controller. Each lighting ring has a 
maximum current; in addition, the current that may be 
sent to the lighting controller must not exceed 4000 mA.

• Target: The average gray-level value that the lighting ring 
should generate over a gray card. This value is factory-set.

• Calibrated Means: The gray-level value for the ring after 
the last lighting calibration.

To undo any changes made to the current values, click Undo.

Figure 7-2 LIghting Controller window
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• Lighting intensity grid 
Shows the mean, sigma and range gray-level values of the 
lighting rings.

Table 7-1 describes the functions in the Lighting Controller 
window.

Table 7-1    Functions in Lighting Controller window

Area Buttons Description

Lighting Application Lets you select the lighting mode. Click to toggle through the available 
lighting modes.

Next Displays the next view.

Previous Displays the previous view.

Log Records the brightness of each of the lighting rings in the intensity.log file.

Focus Allows you focus the camera with the front access door open. An E-Stop 
alarm window will be visible and a Focus Camera instruction window 
displayed. Note that the system is in E-Stop and no power or control is 
given to the gantry or conveyor belt motors.

Auto Calibration Set Location Sets the location of the calibration plate (available as an option) used for 
auto calibration.

Auto Calibration Automatically calibrates the lighting. You must set the location of the 
calibration plate first. See“Auto Calibration”.

Calibrate on Location Automatically calibrate the system with the gray card. See “Calibration on 
Location”.
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Lighting Calibration Files
Table 7-2 lists the files that are required to perform lighting 
automatic calibration.

Table 7-2    Lighting calibration files

File name Description

CalibratedLightingValues.xml Contains the target means that were achieved after lighting automatic 
calibration took place and displays the same values that were displayed in the 
Targets Achieved column in the Lighting Controller window.
Located in C:\cpi\data.

AutoCalibrationResults.log Contains lighting auto-calibration results and other useful information such as 
current outputs sent to the lighting rings.
Located in C:\cpi\log.

Lighting Ring Image over Grey Area During calibration, an image is taken of each lighting ring over the gray card 
area. These images are saved in the format ‘BBxx.pgm’ where xx indicates the 
lighting ring. For example, BB45R.pgm.
Located in C:\cpi\img.

Lighting Controller Log After calibration has been performed, and if you confirm that changes will be 
saved, the list of currents for each ring before and after calibration is saved to 
this file.
Located in C:\cpi\log.

LightingConfigurationValues.xml Contains all configuration information pertaining to lighting.
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Lens Foreign Body Check

To check that the lens and camera are free from dirt, do the 
following:

1 Place a gray card upside down (white side up) in the 
conveyor, and jog the camera over it.

2 Set the aperture to F16.

3 If some dirt can be seen on the scre0en, jog the camera 
slightly to the left or right.

• If the dirt is still in the same position on the screen, then 
either the lens or the camera is dirty.

• If the dirt disappears when the camera is jogged, then the 
dirt is on the white side of the gray card.

4 Use a lint-free cloth to clean the dirt from the lens or camera.

5 Set the aperture back to F5.6 when finished.
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Camera Testing

To test the Dalsa camera, follow the steps below:

1 Click Start > Programs > Matrox Imaging > Intellicam > Intellicam.

2 Click the Board icon on the toolbar to display the following 
dialog box.

3 Under the Solios folder, make sure that the icon next to 
Solios/CL medium 0 shows an ‘A’ (indicating Active).
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4 Click the Open icon on the toolbar to open the file 
SOLIOS_4M60_10CONTINUOUS.DCF located in the  
C:\cpi\data folder.

5 Click the Camera tab and click Continuous Safe Grab.

The window that appears is the viewing screen. You can see 
the live image if you turn on the light. 



8-4 Agilent U1840A Medalist sj5000 Hardware Manual

8 Camera and Lighting Controller Testing

Follow these steps to check the camera settings.

1 In Windows Explorer, navigate to C:\cpi\plc\terminal and 
double-click terminal.exe. 

2 From the Terminal window, open dalsa.trm. 

3 Type GCP in the command line.

4 Check that SYNC Frequency, Internal Exposure Time, 
Camera Link Mode, and Video Mode are as shown in the 
following:
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Lighting Controller Testing

To test the lighting controller (SLC-800), follow the steps below:

1 In Windows Explorer, navigate to C:\cpi\plc\terminal and 
double-click terminal.exe.

1 From the Terminal window, open slc800-new.trm.

2 Click Settings > Communications.

Make sure the settings are as follows, then click OK:

3 Click MAX CURR 1-4 and check that the feedback is as follows: 
1MC4000 
2MC4000 
3MC4000 
4MC4000

4 Click CURRENT 1-4 and check that the feedback is as follows: 
1SC1100 
2SC1200 
3SC2500 
4SC2700

5 Click LGT ON + TRIG and check that the feedback is ST050TS0.

Baud Rate 115.2K
Data Bits 8
Stop Bits 1
Parity None
Flow Control None
Connector COM2
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The Terminal window should now show the following:

6 Click Level 1 to display the Level 2 window:

7 Click MAX CURR 5-8 and check that the feedback is as follows: 
5MC4000 
6MC4000 
7MC4000 
8MC4000

8 Click CURRENT 5-8 and check that the feedback is as follows: 
5SC2800 
6SC1200 
7SC2000 
8SC800
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The Terminal window should now show the following:

9 Keep clicking the Level button at the bottom right, until 
Level 1 appears.

10 Click SEG CURR and check that the feedback is as follows: 
*4SS0500@M*5SS0500@M*6SS0500@M*7SS0500@M*

11 Type in the following: 
4SS469 
5SS469 
6SS469 
7SS469

12 Click Read and check that the feedback is as follows: 
‘RYSC@R1SC857,0,3757*@R2SC957,0,3757*@R3SC22257,0,37
57*@R4SC2457,469,3757*@R5SC2557,469,3757*@R6SC957,4
69,3757*@R7SC1757,469,3757@END*’

NOTE The most important feedback result is when the READ button is clicked.  
If there is no value in the middle of the each ring, as shown in the 
example 4000*@R6SC700,0,4000, then this ring is not segmented. If the 
feedback is 4000*@R6SC700,500,4000, then the ring is segmented. 
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13 Keep clicking the Level button at the bottom right, until 
Level 3 appears.

14 Perform the following checks:

NOTE The camera must be in acquisition mode for the different lighting rings to 
be triggered on and off.

Click this: Check that feedback shows this:

90 Ring 01FF@F*

The red 90 degree ring in the lighting head should turn on.

70 Ring 02FF@0*

The red 70 degree ring should turn on and the 90 degree ring 
turn off.

60 Ring 04FF@2*

The red 60 degree ring should turn on and the 70 degree ring 
turn off.

45a Ring 40FF@2*

The red 45a degree ring should turn on and the 60 degree ring 
turn off.

45b Ring 20FF@0*

The green 45b degree ring should turn on and the 45a degree 
ring turn off.
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The Terminal window should now show the following:

15 Click Level 3 to move to level 4. 

In addition to having lighting rings (such as the 90 degree 
ring), the lighting head is also divided into eight segments. 
The segments contain four rings, which are tested in level 4.

16 Perform the following checks:

45c Ring 10FF@F*

The blue 45c degree ring should turn on and the 45b degree ring 
turn off.

45d Ring 08FF@6*

The red 45d degree ring should turn on and the 45c degree ring 
turn off.

Click this: Check that feedback shows this:

Click this: Check that feedback shows this:

45a_d S1 7801@0*

A segment in the lighting head should turn on and the 45d 
degree ring turn off.

45a_d S2 7802@1*

The next segment (in an anti-clockwise direction) should turn on 
and the previous segment turn off. As you click the following 
buttons, the segments should turn on (and off) in sequence.

45a_d S3 7804@3*

45a_d S4 7808@7*

45a_d S5 7810@0*

45a_d S6 7820@1*
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The Terminal window should now show the following:

17 Click Level 4 which returns you to the level 1 window.

18 Click off and check that the feedback reads 0000@0*. 

At this point none of the LEDs should be on. The lighting 
controller is now fully tested.

19 Close the Terminal window. When prompted to save changes 
to the terminal settings, click No.

45a_d S7 7840@3*

45a_d S8 7880@7*

Click this: Check that feedback shows this:
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This chapter describes the procedure for downloading PLC 
programs from a PC to the Medalist sj5000. The procedure 
applies to both the sj5000 Single Lane and sj5000 Dual Lane.

Both systems use the Omron CP1H X40DT1-D PLC. This PLC is 
programmed using the Omron CX-Programmer Version 6.1.

The PLC programs can be downloaded using either a USB cable 
or serial cable (supplied with the sj5000) between the PC and 
the PLC. Downloading with a USB cable will be faster.
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Downloading Using a USB Cable

If you are using a PC other than the one on the sj5000, it must 
have CX-Programmer version 6.1 installed.

The download procedure is as follows:

1 Connect a USB cable between the PC and the USB port of the 
PLC. 

2 Launch CX-Programmer version 6.1.

3 Click File > Open to open c:\cpi\data\PLC\sj5000.cxt.

4 Click PLC > Online. 

The color of the program pane will change from white to 
gray. If this does not happen, check the cable.

5 Click PLC > Transfer > To PLC.

Figure 9-1 CX-Programmer version 6.1 window
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6 In the Download Options dialog box, set the following and 
then click OK.

a Select all items (Programs, Settings, Symbols, Comments, 
and Program Index). 

b Select Transfer files of all tasks.

c Do not select Exclude Port (Serial 1/2) of PLC Settings from the 
transfer target.

7 Click Yes in the dialog boxes that appear.

8 When the Download Successful message appears, click OK. 

9 Click Yes to return the PLC to monitor mode.

The download is now complete. 
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Downloading Using the Serial Cable

The RS232 cable is supplied with the sj5000. The download 
procedure is as follows:

1 Connect the RS232C cable between the PC (COM port 1) and 
port 1 on the PLC.

2 On the control panel move PLC dip switch 4 on. (This sets the 
PLC serial communications protocol to Auto.)

3 Launch CX-Programmer version 6.1.

4 Click File > Open to open c:\cpi\data\PLC\sj5000.cxt. 

5 In the left pane, right-click NewPLC1(CP1H) Offline. 

6 In the Change PLC dialog box, set the following:

d Select CP1H for Device Type and click Settings. Then in the 
Device Type Settings dialog box, select X for CPU Type 
and click OK.

e Select Toolbus for Network Type.

f Click OK.

7 Click PLC > Online. 
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The color of the program pane will change from white to 
gray. If this does not happen, check the cable.

8 Click PLC > Transfer > To PLC.

9 In the Download Options dialog box, set the following and 
then click OK.

a Select all items (Programs, Settings, Symbols, Comments, 
and Program Index).

b Select Transfer files of all tasks.

c Do NOT select Exclude Port (Serial 1/2) of PLC Settings from 
the transfer target.

10 Click Yes in the dialog boxes that appear.

11 When the Download Successful message appears, click OK.

12 Click Yes to return the PLC to monitor mode.

13 Move PLC dip switch 4 to the off position.

The download is now complete. 
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Selecting Dual or Single Lane Operation

To select dual lane operation, simply move PLC dip switch 6 to 
the on position, and press the PLC RESET button on the front of 
the machine. 

To revert to single lane operation, move the dip switch back to 
off, and press the PLC RESET button on the front of the machine.
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WARNING Barcode readers contain laser equipment. Do not stare into the 
beam.
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Microscan MS-4 USB Barcode Reader

This section describes how to set up one or more Microscan 
MS-4 barcode readers.

• Install Microscan ESP Software

• Install USB-to-Serial Virtual Com Port Driver 

• Download Barcode Reader Setup File

• Set Up Multiple Barcode Readers

• Align Barcode Reader

• Test Barcode Reader Using HyperTerminal

• Configure sj5000 Software

Install Microscan ESP Software
The Microscan ESP software is used to set up and download the 
setting files into the barcode reader. It also serves as a good 
visual tool to align, calibrate and troubleshoot the barcode 
reader.

1 Insert the Microscan Tool CD into the drive. The installation 
software should be launched automatically.

2 Click ESP Software.

3 Click Current Version > ESP Software.

4 Follow the instruction on the screen to complete the 
installation.

Install USB-to-Serial Virtual Com Port Driver 
The Virtual Com Port driver causes each connected USB 
barcode reader to appear as a separate COM port in the PC. The 
sj5000 reads and writes to these COM ports to trigger the 
barcode readers and receive barcode strings.

1 Connect the barcode readers to the USB ports on the sj5000 
PC. 

Bear in mind that the driver has to be installed whenever a 
barcode reader is connected to the PC. If you add another 
barcode reader later, the driver will have to be installed 
again. 

2 Browse the Microscan Tool CD and double-click the 
installation program \Accessories\VCPD\Driver\DPInst.exe.

3 In the dialog boxes that open, click Next, Continue Anyway, and 
Finish to complete the installation.
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Upon successful installation, all connected barcode readers 
will appear in the Windows Device Manger as new COM ports 
in the Ports category. In the following example, the MS-4 
barcode reader appears as COM7.

4 Note down the COM port number of each barcode reader 
connected to the sj5000. 

Download Barcode Reader Setup File
Use the Microscan ESP software to download the standard 
setup file into the MS-4 barcode reader. Make sure the MS-4 
barcode reader is already connected to the USB port.

1 Launch the Microscan ESP software.

2 Select the barcode reader model (MS-4) and click OK.
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3 When prompted to connect to the MS-4 barcode reader 
immediately, click No.

4 Open the standard MS-4 ESP setup file  
C:\Installation\Barcode\MS4-1.esp.

5 When asked again to connect to the MS-4 barcode reader, 
click Yes.

6 Select RS232 protocol.

7 Select the COM port that you noted in the previous 
procedure, and click Connect. 

8 Click Send/Recv > Send to Reader > Send and Save.

This will download the parameters from MS4-1.esp into the 
barcode reader and save them in the flash ROM permanently. 
The barcode reader will emit a long beeping sound, and 
disconnect and reconnect again. This completes the setup file 
download.
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Set Up Multiple Barcode Readers
Each barcode reader is identified by the header that it sends to 
the sj5000 software upon successful barcode reading. In the 
standard MS-4 barcode setup file, the header is set to ‘0’ by 
default. If more than one barcode reader is connected, the 
header will have to be incremented as described below. 

Make sure all barcode readers are properly connected to the 
USB ports before proceeding.

1 Launch the Microscan ESP software.

2 Select the barcode reader model (MS-4) and click OK.

3 When prompted to connect to the MS-4 barcode reader 
immediately, click No.

4 Open the standard MS-4 ESP setup file  
C:\Installation\Barcode\MS4-1.esp.

5 Select RS232 protocol.

6 Select the COM port for each barcode reader that is 
connected and click Connect. 

7 Click Output Format.
8 When asked whether to synchronize with the reader, click 

Receive to receive existing data output format into the screen.
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For the first barcode reader connected, the preamble is set to 
‘0’. For subsequent barcode readers, this header should be a 
running number starting with ‘1’ for the second barcode 
reader.

9 Type in the correct number in the Preamble field. 

10 Click Send and Save to save the new setting into the barcode 
readers permanently.
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Align Barcode Reader
The barcode reader has to be properly aligned physically to 
ensure that it captures good legible images from the target. This 
can be done by using the Microscan ESP software which 
provides a real-time visual environment for barcode alignment.

1 Load a board with a barcode in the desired location for 
barcode detection.

2 Launch the Microscan ESP software and go into Camera 
mode by clicking Camera.

3 Click Test.

The barcode reader will take a continuous shot and decode 
the barcode. 

4 Adjust the barcode reader until it achieves a good reading 
(Percent Decode > 90%).

5 Fix the barcode reader position and click Stop to finish the 
test.
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Test Barcode Reader Using HyperTerminal
Test all connected barcode readers one by one: 

1 Open HyperTerminal and connect to the barcode reader’s 
COM port (9600, no parity, 8 data bits, 1 stop bit, no flow 
control). 

2 In the Terminal window press the space bar a few times (to 
connect).

3 Type <+> in the Terminal window.

This command causes the barcode reader to scan for a valid 
barcode and either return a barcode string or a no-read.

Configure sj5000 Software
Once the barcode readers have been tested, the sj5000 software 
has to be configured so that it knows which COM ports it should 
wait for barcode packets on. The read trigger string must also be 
configured (the string that the sj5000 will send to the barcode 
readers when it wants them to attempt to read a barcode). 

1 Launch the sj5000 software. From the Tools menu, click the 
Barcodes folder. 
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2 Add each barcode reader’s COM port to the Serial Port list as 
follows: click the + button, select the COM port, and click OK.

3 If it is necessary to configure the Read Trigger string, type it 
in the Read Trigger field. For the Microscan USB barcode 
readers, the default string is <+>.

If you need to remove a COM port, select it from the Serial Port 
list and click the – button. 
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Microscan MS-820 Serial Barcode Reader

• Set Up Single Barcode Reader

• Set Up Dual Barcode Reader

Set Up Single Barcode Reader
Plug the serial cable (p/n 5186-4835) into the XP-40 port on the 
breakout box as shown below, and plug other end into the 
MS-820 barcode reader.

Plug the trigger cable into the XS-42 port on the breakout box.

Program the Barcode Reader

Install the software as described in “Install Microscan ESP 
Software” and do the following:

1 Start the ESP software.

2 Select MS-820 in the Select a model dialog box and click OK.

3 When prompted to connect to the barcode reader, click Yes. 

4 Ensure COM port 4 is selected and click Start. 
5 Click App Mode.

6 Click File > Open to open the setup file Single 820.esp.

7 Click Send/Recv > Send to Reader > Send and Save. 
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This will download the setup file to the barcode reader. The 
reader will emit a beep to indicate the download was 
successful.

8 To test the barcode reader, click Terminal.
a Click Enable Serial Trigger > Send Trigger Character. 

(Alternatively, trigger the conveyor entry sensor.)

b Scan a barcode and the decoded barcode text should 
appear in the Terminal window. 

9 Close the ESP software and launch the sj5000 software.

10 From the Tools menu, click the Barcodes folder. 

11 Ensure that the settings are as follows:

c Click Read and scan a barcode with the barcode reader. 

The barcode text should be displayed. 

12 Place a board in the sj5000 and scan a barcode. 

The barcode text should be displayed.

Serial Port 4
Baud Rate 9600
Byte Size 8
Parity None
Stop Bits 1
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Set Up Dual Barcode Reader
Plug the serial cable (p/n5186-4835) into the XP-40 port on the 
breakout box as shown below, and plug other end into the 
MS-820 barcode reader. 

Plug the trigger cable into the XS-42 port on the breakout box.

There are two setup files for dual lane mode. Two barcode 
reader are set up as a daisy chain, and each barcode reader is 
identified by a different header.

• 820DL00.esp is the master barcode reader with header 00

• 820DL01.esp is the slave barcode reader with header 01

Program the Barcode Readers

Each barcode reader can only be programmed from port XP-40 
on the breakout box.

Install the software as described in “Install Microscan ESP 
Software” and do the following:

1 Start the ESP software.

2 Select MS-820 in the Select a model dialog box and click OK.

3 When prompted to connect to the barcode reader, click Yes.

4 Ensure COM port 4 is selected and click Start.
5 Click App Mode.

6 Click File > Open to open the setup file 820DL00.esp.

7 Click Send/Recv > Send to Reader > Send and Save.

Serial cable to barcode reader 1
Serial cable to barcode reader 2
Trigger cable
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This will download the setup file to the barcode reader. The 
reader will emit a beep to indicate the download was 
successful.

8 Remove the barcode reader from the XP-40 port and replace 
with the slave barcode reader. 

9 Click Auto connect to communicate with the barcode reader. 

10 Click File > Open to open the setup file 820DL01.esp.

11 Click Send/Recv > Send to Reader > Send and Save to save this 
to slave barcode reader.

12 Plug the master barcode reader to the XP-40 port and the 
slave barcode reader to the XP-41 port on the breakout box. 

13 To test both barcode readers, click Terminal.
a Click Enable Serial Trigger > Send Trigger Character. 

(Alternatively, trigger the conveyor entry sensor.) 

b Scan a barcode with the master barcode reader and the 
decoded barcode text should be displayed with a 00 
prefix. 

c Scan a barcode with the slave barcode reader and the 
decoded barcode text should be displayed with a 01 
prefix. Note that it will be displayed only when the master 
barcode reader times out.

14 Close the ESP software and launch the sj5000 software. 



10-14 Agilent U1840A Medalist sj5000 Hardware Manual

10 Setting Up Barcode Readers

15 From the Tools menu, click the Barcodes folder. 

16 Ensure that the settings are as follows:

17 Click the Machine Specific tab and select the options shown 
below.

18 Click the Reader Specific tab and click Read.

a Use the master barcode reader to scan a barcode. 

b Use the slave barcode reader to scan a barcode. The 
barcode text should be displayed with a 01 prefix. 

19 Place a board in the sj5000.

20 Scan a barcode with the master barcode reader.

The barcode text should be displayed with a 00 prefix.

21 Do the same with the slave barcode reader.

The barcode text should be displayed with a 01 prefix.

Serial Port 4
Baud Rate 9600
Byte Size 8
Parity None
Stop Bits 1
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Handheld Barcode Reader

Install the Barcode Reader
1 Connect the gray communications cable to the handheld 

barcode reader, and connect the other end to the blue 
USB-to-Serial Converter cable. 

2 Connect the blue USB connector to one of the USB ports on 
the PC. 

3 Plug the 5 V power cable into the RS232 connector of the 
handheld barcode reader. Plug the other end into a free USB 
port on the PC. 

The barcode reader will flash on and off, and then emit three 
beeps. 

4 Install the USB-to-Serial driver:

a Insert the Trendnet TU-S9 Software Installation CD into 
the drive.

b Browse to the \Driver\Win98_2003 folder and 
double-click the Setup file. Follow the instructions on the 
screen to complete the installation. 

5 Once the installation is completed, connect the blue 
converter cable to a free USB port on the PC.

6 Open the file c:\cpi\data\config.txt and check that it 
contains the following line:  
Barcode 1 0 1 

   

Handheld Barcode reader
5186-2218 

Grey RS232 Comm Cable 
5186-2186 

5V power cable 
5186-xxxx 

USB to Serial Converter
5186-xxxx 
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7 Click Start > Run. Type regedit in the command line and 
press Enter. 

a Find HKEY_LOCAL_MACHINE\Software\MV 
Technology\GS-1\Barcode. 

b Ensure that Intermec appears in the Data column for both 
Active and Type string names.

c Double-click the Barcode folder and then click Intermec. 

d Ensure that the Dword named Lines shows the value 2 in 
the Data column, and the Dword named Serial Port shows 
the same number in the Data column as the serial port 

NOTE Backup any registry keys for the barcode key before editing.
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number in the Device Manager (see “Checking the Serial 
Port Number in Device Manager”).

e Exit the editor and restart the PC. 

Checking the Serial Port Number in Device Manager

To find out the serial port number:

1 Make sure the barcode reader is connected.

2 Open the Device Manager by clicking Start > Control Panel > 
System > Hardware > Device Manager.

3 Look under Ports to find the USB-to-Serial port as shown 
below. 

Program the Barcode Reader
To program the barcode reader, refer to the Datalogic DLC7000 
Series Manual. Then do the following:

• Scan the barcodes Restore Defaults, RS232, and English from the 
manual with the reader. After each scan the reader should 
emit two audible beeps. 

• Next scan Code 39. When Code 39 is scanned the reader 
should only beep once.
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This chapter is intended to assist you in solving problems that 
you may encounter with your system. It provides 
troubleshooting information for the failure modes that happen 
most frequently and with the greatest effect on productivity, 
that is, those that would cause the line to stop. 

For the locations of terminals, relays, PLC displays, PSUs and 
MCBs, refer to the Electrical Drawing document (part number 
5186-5861).
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Error Messages

Emergency Stop (E-Stop) error message

Agilent AOI systems have four pushbutton stops and one 
interlock E-Stop connected to the front access door of the 
machine. If any one of these five hardware devices is not 
making contact an E-Stop condition will occur. 

• If all E-Stop hardware is intact and functioning, request 
Troubleshooting the Safety Relay.doc from Agilent Support. 
This document discusses what terminals to check for open or 
closed circuits and voltage, to pinpoint the exact problem.

• See the Electrical Drawing document for wiring details.

No barcode read in the software
• Verify that the barcode reader is working. Do not stare into 

the barcode reader; observe the manufacturer’s warning. 
Typically the reader is working if a red laser line is present. 

• Verify that the barcode reader is connected to the correct 
COM port at the back of the system. If the system was not 
purchased to work with a barcode reader, you will need 
additional hardware, either Agilent supported or purchased 
directly from the manufacturer, to supply power and trigger 
to the reader. For more information, contact Agilent Support.

• Check that the correct COM port is set in the registry.

• Verify that the barcode reader was set up with a preamble of 
0 and a postamble of CR.

• The communication of the reader barcode can be verified 
using the sj5000 software (from the Tools menu click the 
Barcodes folder), HyperTerminal or the manufacturer’s 
software.

Agilent recommends Microscan barcode readers with ESP 
software.
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Troubleshooting the Software

• Excessive ‘Missing’ component failures

• sj5000 software crashes and will not restart

• Software crashes during inspection

• The gantry speed suddenly dropped and now the system is 
inspecting boards very slowly

• Solder joint false failures

• No image available when using ART station

Excessive ‘Missing’ component failures

If the software was running with minimal false failures 
previously:

• Ensure that the lighting calibration is correct (and was 
correct when the software was run previously).

• Check whether the board has been re-trained for 
presence/absence.

sj5000 software crashes and will not restart

If the sj5000 software crashed and will not restart when you try 
to launch it again from the desktop icon, do the following:

• Verify that the sj5000 software has completely shut down by 
opening Windows Task Manager and checking the 
Applications tab.

If SJGUI.exe or AOInEngine.exe is shown, select it and close 
it by clicking End Task. 

• There could be a PLX file issue that caused the problem and 
because the software tries to launch the last board used, it 
continues to crash during startup. 

If this happens, delete the file c:\cpi\data\names.txt and the 
sj5000 software will start using a default program name. 

• In both cases always send the log files, a board package and a 
snapshot of the system to Agilent Support. Please include as 
much detail as you can (including screen captures if 
possible) to help us re-create the problem.
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Software crashes during inspection

If the software crashes while inspecting a board, it is probably 
related to the algorithm setup or a gantry failure.

• First restart the software but run a different board program 
for a board of similar size but that uses a different database. 
The goal here is to quickly isolate the CAD program and 
gantry to see which is causing the system to crash. 

• Review any recent changes that were made (for example, if a 
new database was assigned or an algorithm tweaked) and see 
if something stands out. Let the support team know of any 
recent changes or problems.

• If the gantry runs fine on the second board, try reloading the 
original CAD program but assign a different database. This 
could be any database but c:\cpi\data\vispcad may be the 
safest.

• If the program runs fine then try reloading the original 
database and rerun the program. If the program crashes in a 
similar place, it is an algorithm setting or something in the 
database that caused the problem. The problem algorithm 
can be identified by enabling diagnostic logging in the Tools 
menu and then reviewing the last entries of the jmcpi or 
jmasal.log files.

• For additional support, send a system snapshot, board 
package, screen captures, and any other details of the 
problem to Agilent Support immediately.

The gantry speed suddenly dropped and now the system is inspecting 
boards very slowly

If the system loses the XY table limits, the gantry acceleration is 
reduced to 0.5. This may happen following an E-Stop during 
inspection. 

• To solve this, select the XY Table folder from the Tools menu 
and click Set Limits. The gantry will then re-learn its limits.

• Also check the XY table acceleration settings. 
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Solder joint false failures

Review and follow the recommended best practices (the 
Algorithm Manual) to solve the problem. Beyond that, perform 
the following procedures.

• For c-type and r-type devices, set Top Plane to ‘true’ to 
reduce stray reflections from neighboring devices.

• If an s-type device is locating well and has joints well tuned, 
teach the individual false failing joint as good (only 
applicable if using JointMVC or JointSLA).

• When tuning an s-type device: 

• Make sure the lead length and location are correct

• Shift the joint position (light blue box) away from the end 
of the lead. The blue box should be positioned adjacent to 
the lead end with minimal coverage of the actual lead.

• Reduce the joint box length to make sure it does not 
extend beyond the pad.

• Reduce or enlarge the joint box width to cover the pad 
width.

No image available when using ART station

The problem is the image size.

• Open the Config.txt file located in the c:\cpi\data folder and 
look for the line Image_save 52 1000 1000000 –1 1.  
Change 1000000 to 2000000. This will increase the image size 
and solve the problem.
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Troubleshooting the System Power

If a power failure occurs
• Check all MCDs and RCBO for any trip. 

• If there is no trip, check the incoming facilities.

• Is there power at the mains supply?

• Is the mains isolator in the on position?

• Is Q1 (the main RCBO) in the on position?

• Is the RUN indicator light illuminated?

• Is the START key switch in the ON position?

• Check that Q2 (24 V PSU) is on.

• Check Q3 and Q4 (24 V DC) are on.

• Check the supply voltage at the main terminals.

Troubleshooting the 24 V Supply

If there is no 24 V supply
• Check the 24 V supply PS1 by either measuring the output of 

the power supply or by looking at the indicator light (the 
latter solution is not as good a test as the former). 

• Check that MCB Q2 is on.

• Check the input ac voltage for the PS1.
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Troubleshooting the Conveyor

• Conveyor will not load a board

• Board passes straight through the machine and will not stop 
for inspection

• In-Position sensor sensitivity

• Failed boards will not exit the system

• Conveyor belt(s) reverse direction unexpectedly

• Clamp motor continuously rotates

• Board is not clamped

• Inspection yields fiducial mis-reads

• Conveyor will not run

• Conveyor 1 will not run

• Conveyor will not run because there is no output from PLC

• Drives will not move/home/move to a given width

• Cannot manually adjust the width of the conveyor rail

• Conveyor rails will not align properly

Conveyor will not load a board
• The SMEMA cable may not connected. Check the connection 

at the upstream conveyor and the back of the sj5000.

• The sj5000 may believe there is a board already present. 
Check that all three sensors are not flagged by either a board 
or gantry. All sensors have sensitivity potentiometers that 
may be set too sensitive and are identifying the rail or other 
hardware as a board. This can be verified by reviewing the 
input PLC modules. 

Board passes straight through the machine and will not stop for 
inspection
• The sj5000 is in pass through mode. Check the RAIL 

switch(es) on the switch plate and ensure it is set to INSP 
(inspect).

• The In-Position sensor is not being flagged as the board 
passes through the sj5000. This can be verified at the PLC 
module or by manually flagging the position sensor.
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In-Position sensor sensitivity

The In-Position sensor is triggered by the gantry or it is not 
triggered by the board.

• Move the gantry over the sensor and decrease the sensor 
sensitivity until the sensor is not triggered by any part of the 
gantry or camera.

• Load a board and increase the sensor sensitivity until the 
sensor is triggered by the board and not by the gantry.

• Adjust the sensor position to detect areas of the board where 
there are no holes or dark non-reflective areas.

Failed boards will not exit the system
• The downstream SMEMA cable is not connected. Check the 

sj5000 and the downstream conveyor.

• The downstream SMEMA cable does not meet Agilent 
requirements. For older systems, the cable must have an 
additional pin 8 and for newer systems additional pin 5 for 
relaying the bad board signal. 

• Verify that relays KA5, KA6 and KA7 are functioning for 
single lane machines.

• On dual lane machines, for SMEMA downstream lane 1, 
verify that KA 5, KA6, and KA7 are functioning. For lane 2, 
check KA 12, KA13 and KA14.

Conveyor belt(s) reverse direction unexpectedly

This is typically related to a bad motor cable. The cables in 
question are 5186-6308 and 5186-6309, they are routed from the 
main control panel in the back of the system to each conveyor 
motor.

• Refer to the Electrical Drawing document and verify that 
the cables at XBM3 and XBM4 are not loose, and that the 
cable connections at the motors are not loose or damaged.

• If necessary, replace the cables.

Clamp motor continuously rotates
• Reset the clamp home sensor.
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Board is not clamped
• Check whether the clamping mechanisms are blocked. If they 

are, lubricate them.

• Ensure the RAIL switch(es) on the switch plate is set to the 
INSP (inspect) position.

• Turn the MAINT. SWITCH to the ON position. From the 
Maintenance window, force the clamps up and down. 
Visually check if the motor is working.

• Ensure the Disable Clamping output has not been set. (Refer 
to the Engineering Manual, Tools Menu: Machine IO.)

• Check if the clamp drive motor is operating and verify 24 V 
DC power to the drive.

Inspection yields fiducial mis-reads

Typically this is a software problem that occurs when the 
fiducial appearance has changed. See “Fiducial Setup” in the 
Engineering Manual.

In some instances this could be a hardware setup issue where 
the board is not reaching the stops or is overshooting. 

• Check if the board is tight in the conveyor.

• Check the belt condition.

• Check the conveyor speed.

• Check that both belts are working.

• Check the position sensor sensitivity.

Conveyor will not run
• Refer to the Electrical Drawing document.

• Check that the conveyor is not obstructed.

• Check that MCB Q4 is on. 

• Check that all E-Stop buttons are pulled out. Examine the 
three indicator lights on the relay and verify that KA4 is 
activated.

• Check that the Entry sensor is functioning and that this 
signal is read by the PLC.

• If SMEMA is used, ensure that a Not Busy (PLC input 0.01) 
signal is sent from the downstream machine.

• Check that P404 (stepper driver) is working.



11-10 Agilent U1840A Medalist sj5000 Hardware Manual

11 Troubleshooting

Conveyor 1 will not run
• Check that PLC output 100.00 is on. (All input and output 

have indicator lights on the PLC.)

• Check that relay KA4 is energized.

Conveyor will not run because there is no output from PLC
• When an error occurs in the PLC, an error message will be 

displayed. Check the message for the cause and the action to 
be take.

Drives will not move/home/move to a given width
• Check that the motors are not slipping on their coupling.

• Check the position of the AWA sensors.

• Check that there is nothing obstructing the conveyor.

• Check that the E-Stop circuit is reset.

• Check the power to the P404 and look for indicator lights on 
the P404. The middle LED should be green or orange.

• Check for 24 V DC power to P404 (stepper driver).

• Check that Q2, Q3 and Q4 are on.

• Check that KA4 (on a single rail) is on to energize all motors. 

• Check whether it is the PLC that is not allowing the move. 
The PLC may not allow a move if there is a board in the 
machine or some of the sensors are triggered. 

• Check that the three AWA sensors are working by checking 
that their indicator lights are on. 

• Check that the cabling of the motors is connected to the 
terminals above P404 (stepper driver).

Cannot manually adjust the width of the conveyor rail
• Check that motors are not slipping on their coupling.

• Check that there is nothing obstructing the conveyor.

• Check that the E-Stop circuit is reset.

• Check that the AWA IN and AWA OUT buttons are operating by 
pressing them. The PLC inputs for in/out are 00.04/00.05.

• Check the power to P404; look for indicator lights. The 
middle and top LEDs should be green or orange. The LEDs 
should not be red. 

• Check that KA1 (on the single rail) is on to energize all 
motors.
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• Check whether it is the PLC that is not allowing the move. 
The PLC may not allow a move if there is a board in the 
machine or some of the sensors are triggered. 

• Check that the conveyor rail is not on the AWA Limit sensors.

• Check the cabling of the motors.

Conveyor rails will not align properly
• Perform AWA calibration.

• Check that the left minimum sensor and the right alignment 
sensor are in-line. This can be done by measuring and 
comparing the distance from the sensor to the structure 
edge.

• Check all sensors are working by placing something (for 
example, a piece of card) at various parts of the rail to see if 
it triggers the associated sensor/input.

• Ensure that when the AWA software is executing the aligning 
operation, the relay KA2 is activated so as to allow the right 
side motor to be moved.

• Check the cabling of the motors.
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Troubleshooting the Camera

• Camera image is completely black

• Camera will not work

• Lighting rings will not work

• Lighting controller will not work

• Images seem darker than normal

• Wrong lighting values or incorrect color in lighting menu

• Unable to auto-scale

Camera image is completely black
• Verify that the cap is not on the camera lens. Typically 

systems are shipped with the cap on the camera lens. 

• Check that the cables (part numbers 5186-5778 and 
5186-6325) are connected from the camera to the Frame 
Grabber.

• Check for 12 V DC on pins 4 and 16 on the cable (p/n 
5186-6324) connected to the lighting controller.

Camera will not work
• Check that the PC is on.

• Check that the cable (p/n 5186-6325) and the two camera 
link cables on the camera are connected correctly to the 
Frame Grabber. Data1 and data2 on the camera should be 
connected to the upper and lower connector of the Frame 
Grabber respectively.

• Check that the green LED of the camera is on when the PC is 
on. 

• Check for 12 V DC between pins 4 and 16 on the cable (p/n 
5186-6324) connected to the lighting controller.
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• Check the 2 Amp porcelain fuse inside the PC. 

• Check the serial connector for the lighting controller. 

• Check the image for isolated odd dots. If you find these, 
replace the cables. Contact Agilent Support for the detailed 
procedure.

• Check the image using the Intellicam software (see “Camera 
Testing”).

Lighting rings will not work
• Shut the system down completely and then restore power.

• Perform manual initialization by clicking individual rings in 
the Lighting Controller window of the sj5000 software (from 
the Tools menu, click the Lighting Controller folder). 

• Try to calibrate using a Fotowand gray card (see “Lighting 
Calibration”).

Lighting controller will not work
• Check that MCB Q3 and Q4 are on.

• Check that the 24 V DC power supply is on.

• Check that the LED on the lighting controller is on.

Images seem darker than normal
• Lighting rings need calibration. Lighting rings will degrade at 

different rates depending upon use and variations 
introduced during manufacturing. Therefore lighting 
calibration should be verified during normal maintenance 
schedules and more often if significant changes in the 
required amperage are noted.

• Lighting rings or individual LEDs could be damaged or 
non-functional. This can be verified using a dental mirror 
under the camera and checking the LEDs from the image in 
the Lighting Controller window. If a burned out LED is noted 
during maintenance procedures contact Agilent Support 
immediately.

• The camera aperture may have been changed. Reset it to F5.6 
(see “Setting the Lens Aperture”).
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Wrong lighting values or incorrect color in lighting menu
• Place the lighting head over the ball bearing and verify if 

each ring is complete. If not, replace the defective LED or 
bank of LEDs.

• Check if the right color is displayed for each ring. If not, 
verify the wiring to the lighting controller.

• Verify that unified_ligt_map.txt, SLC800LightingValues.xml, 
SLC800Initialisation.xml and 
LightingControllerIntensityTargets.xml are present and not 
corrupted. Replace any missing or corrupted files (contact 
Agilent Support). 

• Try to calibrate using a Fotowand gray card (see “Lighting 
Calibration”). 

Unable to auto-scale
• When fiducial 1 is too close to the maximum or minimum 

limits of the XY gantry inspection range, auto-scale cannot be 
completed. Try auto-scaling on a different fiducial which is 
not close to the stage limits.
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Troubleshooting the Lighting Controller

If the lighting controller is not working

Check that the lighting controller is enabled in the Windows 
registry.

1 Click Start > Run, type regedit in the command line and click 
OK.

2 Go to HKEY_LOCAL_MACHINE/SOFTWARE/MV 
Technology/GS-1/LightingController.

3 Double-click Enabled.

4 Type 1 in the Value data field and click OK.
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Troubleshooting the Lighting Tower

If the lighting tower will not operate
1 Check that the lighting tower is plugged in.

2 From the Tools menu, click the Machine IO folder. 

3 Activate all the lights: select any green, amber, or red light 
and press the space bar to activate it. Press the space bar 
again to deactivate.

4 Check that the PLC is operating.

5 Check that the connector is intact and undamaged.

6 Check the LEDs.

7 Check the wiring.
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Troubleshooting the PC and Monitor

If the PC is not working
• Check that the PC is plugged in and switched on.

• Check that MCB Q5 is on.

• If UPS is used, make sure that it is switched on. 

• Determine if any hard disk is damaged using the Matrix 
Storage Console utility. Click Start > All Programs > Intel Matrix 
Storage > Matrix Storage Console to view a report on the hard 
drives. If a hard disk has failed, contact Agilent Support to 
get a new hard disk.

• To remove a failed hard disk, open the PC cover, remove the 
power and SATA connectors, and pull out the hard disk.

• To install the replacement hard disk, insert it and then 
connect the power and SATA connectors.

• Restart the PC and check automatic rebuilding. This can take 
three hours.

If the monitor is not working
• Check that the monitor is connected and switched on.

• Check that MCB Q5 is on. 

• Check that the cables are properly connected. 

• If UPS is used, make sure that it is switched on.
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Troubleshooting the Safety Relay

If the safety relay will not reset

Pressing ES RESET on the switch plate will reset the safety relay. 
After a reset, the three indicator lights on the safety relay 
should turn on.

If the safety relay will not reset:

• Check for 24 V supply across the relay terminals A1-A2.

• Check that the emergency stop and door interlock are 
functioning correctly. This is done by checking the continuity 
across terminals:

• Check S11 and S12 for continuity 

• Check S21 and S22 for continuity 

• Check the three indicator lights on the safety relay. If the 
three lights are on, the relay is functioning correctly.The top 
light indicates the power is on. The two bottom lights 
representing circuit number 1 and circuit number 2.

• Check that all contacts and terminations are intact.

• Check the reset circuit activated by the hardware pushbutton 
that shorts out terminals XB5-11 and XB5-12 on the control 
panel.

• If the emergency stop is on and there is no message on the 
monitor, check PLC input 00.02. Check that the LED on the 
PLC is on. If the LED is not on, reset the PLC.
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Troubleshooting the XY Table

When the sj5000 software starts, the parameters for the MEI 
card controller and Kollmorgen drives are downloaded 
automatically and the system homes the gantry. If this does not 
happen, check the system first. The procedures for checking the 
system and additional troubleshooting information are 
provided in this section.

Checking the System
• Check the Hardware

• Download Parameters to MEI Card and Drives

• Move the Axis

Troubleshooting
• Troubleshooting the XY table motor controller

• XY table motor controller is not operating

• Gantry will not home during software startup

• The machine seems to vibrate. How do I know if it is level?

• Motor jumps and gives Amp. Fault

• No light on encoder head

• No power on Kollmorgen drives

• Gantry makes strange noise

• Flashing c1 on the drives

• Flashing r4 (or r5 or r6) on the drives
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Checking the System
Perform the following procedures in sequence:

• Check the Hardware

• Download Parameters to MEI Card and Drives

• Move the Axis

Check the Hardware

1 Reset the E-Stop circuit.

2 Remove the rear access panel. On the control panel, make 
sure that Q7, Q8, and Q9 (for Z-axis, if used) are switched on. 
These are the circuit breakers for the gantry. 

3 Check that both the two Kollmorgen drives (also located on 
the control panel) have a 24 V supply going to them.
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4 Place a multimeter between L1 and L2. It should read either 
110 VAC or 230 VAC, depending on the input line voltage 
used.

5 Turn off MCB Q7, Q8 and Q9.

6 Check the resistance between motor windings, which should 
read as follows: 
Ma and Mb = 2 ohms 
Ma and Mc = 2 ohms 
Mb and Mc = 2 ohms 
If the resistance is greater, it means there is a wire break 
somewhere.

7 Note that the E-Stop should be off.

8 If everything is OK, close the cover to the Kollmorgen drives 
and turn on Q7, Q8 and Q9 (if Z-axis is present).

9 Make sure that the connector highlighted below is connected 
to C3 on the Kollmorgen drive. This connector relays the 
machine IO information (such as positive and negative 
limits) for the axis. Both drives should have this connector. 
For the wiring, refer to the Electrical Drawing document.
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10 Make sure that the cable marked Halls/End highlighted below 
is connected to C2 on the Kollmorgen drive. This cable gives 
feedback on the ‘Halls’ and also on the gantry as it moves 
along the encoder strip. Again, both drives should have this 
cable.

11 At the back of the PC, check that a SyncNet cable (p/n 
5186-6319) is correctly connected to the top LAN-type 
connector on the motion controller card as shown below. 

Cable 5186-6319
connected to
top LAN-type
connector
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12 At the back of the PC, look at the first drive on the left, Axis 0 
or X Axis. Make sure that a SyncNet cable (p/n 5186-4710) is 
connected to the top LAN-type connector in C4 as shown 
below. The bottom SyncNet cable should be connected to the 
top connector in C4 on the drive 2 Axis 1 or Y Axis. 

13 An easy way to find faults on the SyncNet cabling is by 
looking at the lights. There should be an amber light at the 
top and a green light at the bottom of each connector as 
shown above.

14 When all the hardware has been checked and found to be 
working correctly, check the software.
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Download Parameters to MEI Card and Drives

Make sure all hardware is checked and present before 
performing the following procedure.

1 In Windows Explorer, locate the folder c:\cpi\data\mei and 
check that the following files are present:
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2 Go to the folder C:\cpi. Open the ASALRC file with Notepad 
and check the content: 

3 If the above is present, the parameters for the motion 
controller card and both the X and Y axes have to be 
downloaded manually. 

4 Download the parameters as follows:

a Select Start > All Programs > Accessories > Command Prompt.
b Type the following at the command line and press Enter: 

cd \cpi\data\mei\tools 

c Type reset and press Enter:
d To download the parameters to the X axis, type the 

following and press Enter: 
cddriveconfig -download -node 0 -file c:\cpi\
data\mei\x.txt 
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e To download to the Y axis, type the following and press 
Enter: 
cddriveconfig -download -node 1 -file c:\cpi\
data\mei\y.txt 

f To save the parameters to the drives, type the following 
for the X axis and press Enter: 
cddriveconfig -save -node 0 -file c:\cpi\data\
mei\x.txt 

g To save for the Y axis: 
cddriveconfig -save -node 1 -file c:\cpi\data\
mei\y.txt 

5 To save the parameters to the Motion Console (MoCon), 
launch it as follows: locate the folder C:\MEI\MOCON in 
Windows Explorer and double-click MC_XMP_NT.EXE. 

a If necessary, click the M button on the toolbar to open the 
Motor Summary window. On the Config tab, click the Save 
to Flash buttons.
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b In the configuration window that appears, select the 
Controller tab. Then click Controller 0 and click Add All 
Sub-Objects. Click OK.

c You should see the following. Click OK.

d Click OK in the warning message window. 
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Move the Axis

Make sure the hardware has been checked and present, and the 
parameters downloaded before continuing.

Launch MoCon for the following procedures. On the toolbar of 
the MoCon window, the following buttons will be used: 

C - Controller Summary 
S - Motion Supervisor Summary 
F - Filter Summary 
A - Axis Summary 
M - Motor Summary

1 Click the M button on the toolbar. 

a On the Controller tab of the configuration window, click 
Controller 0 and click OK. 
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b On the Action tab of the Controller Summary window, 
click the Reset button for Controller 0.

c On the Config tab, make sure the Sample Rate is set to 
8000. If it is not, the SJ5000.xmp file has to be 
downloaded (follow the instructions in “Download 
Parameters to MEI Card and Drives” to do so).

2 On the MoCon toolbar, click the A button.

a On the Axis tab, make sure both Axis 0, Controller 0 and Axis 
1, Controller 0 appear in the Object List. If not, select them 
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from the Object Pool and click Add to add them to the list. 
Click OK.

The following window appears:

b Open the front access door. If the encoders on both axes 
are reading correctly then the following should happen:

• As the X axis (Axis 0 in MoCon) is moved away from the 
front of the system, the numbers highlighted above should 
decrease.

• As the X axis is moved toward the front of the system, the 
numbers highlighted above should increase.

• As the Y axis (Axis 1 in MoCon) is moved to the right, the 
numbers highlighted above should decrease.
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• As the Y axis is moved to the left, the numbers highlighted 
above should increase.

c If feedback in the opposite direction is received, then the 
sj5000.xmp file has to be downloaded and saved to the 
MEI card again. (The encoder phase should be reversed 
for all motors, see the Motor Summary window.)

d Make sure the both axes are in the middle of the machine. 
Close the front access door and reset the E-Stop circuit.

e Enter the following values in the fields:

3 On the MoCon toolbar, click the F button. 

a On the Filter tab, make sure both Filter 0, Controller 0 and 
Filter 1, Controller 0 appear in the Object List. Click OK.

Encoder resolution
is 1 um, so this 
means a travel
distance of 60 mm
(6000 x 1 um)
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b In the Filter Summary window, select the Coeffs tab. Make 
sure that All Algorithms is selected and that the values are 
the same as shown below.

4 On the MoCon toolbar, click the S button.

a On the MS tab, make sure both MS 0, Controller 0 and MS 1, 
Controller 0 appear in the Object List. Click OK.

b In the MS Summary window, select the Actions tab. Click 
the Clear Fault button for both the X and Y axes, and check 
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that the state of each axis is Idle. (If you do not see the 
window below, go to the next step.)

c If you see the following window instead, the grayed out 
MS1 column indicates that MS0 is controlling both axes. 
The axes should be controlled separately; refer to 
“Mapping the Axes” for instructions on how to achieve 
this.
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5 On the MoCon toolbar, click the M button.

a On the Motor tab, make sure both Motor 0, Controller 0 and 
Motor 1, Controller 0 appear in the Object List. Click OK.

b In the Motor Summary window, select the Config tab. 
Select the Reversed option for Encoder Phase as shown 
below.

c Select the Enabled option for Amp Enable, for both the X 
and Y axes. Amp Enable in the bottom pane should show 
Enabled for both axes. 
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6 Check the Kollmorgen drives. The display on the drive should 
show 2. This means that the drive has enabled correctly. 

7 Go to the MS Summary window. On the Actions tab click the 
Move to Further button. The axis should move in a positive 
direction. Click Move to Further again and the axis should 
move back.

NOTE Make sure the axes are in the middle of the machine.
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8 Do the same for Axis 1. To have the axis move back and 
forward continuously, select the Enabled option for Repeat 
Mode and than click Move to Further. 

9 If the axes are moving, it means the system is ready for 
inspection. Disable the Repeat Mode, disable the motors 
(disable Amp Enable in the Motor Summary window), and 
close the MoCon window.

Mapping the Axes

1 On the MoCon toolbar, click the Object Controller button (to 
the left of the C button). 

2 Open the Controller 0 folder, then the Motion Supervisors and 
Axes subfolders.
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3 First, remove Axis 1 from the control of MS0. 

a Under Motion Supervisors, click MS 0, Controller 0. then 
click Axes.

b Right-click Axis 1, Controller 0 and select Remove Axis From 
List. 

c Click Yes to confirm the removal.

d The Object Explorer will show that Axis 1, Controller 0 is 
no longer under the control of MS0.

4 Now map Axis 1, Controller 0 to MS 1, Controller 0.

a Select the axis and drag and drop it into MS 1, Controller 0. 

b Click Yes to confirm.

5 When this is completed, go to the Motor Summary window. 
On the Config tab, click the Save to Flash buttons. 



11-38 Agilent U1840A Medalist sj5000 Hardware Manual

11 Troubleshooting

Troubleshooting

Troubleshooting the XY table motor controller
• Home the X and Y axes individually, to identify and rule out 

any electrical cable communication issues.

• Jog the X and Y axes individually, to identify and rule out 
motor and encoder communication issues.

• Manually move the gantry to activate the Home and Limit 
markers, to identify and rule out read head cable 
communication issues. 

XY table motor controller is not operating
• Are MCB Q7 and Q8 on? 

• Is there an emergency stop condition?  
Examine the three indicator lights on the safety relay.

• Check that all cables are in position and securely connected.

• Check that safety relays KS4 and KS5 are activated.

• Check that 24 V supply to the amplifiers is present.

• Check that the contactors KS2 and KS3 are at the ON 
position.

Gantry will not home during software startup
• The Anorad gantry has protective metal casings that cover 

the magnets. If the metal plate is damaged, there is a 
possibility that a magnet could be cracked or damaged, 
which would prevent gantry movement across that position.

The machine seems to vibrate. How do I know if it is level?
• Loosen the feet locking nuts and turn each of the adjustable 

feet slightly to verify that each is carrying some weight. If 
they are properly adjusted, all four feet should have similar 
resistance to turning.

• The leveling of the machine should be verified by placing a 
level gauge on the metal railing of both axes of the gantry. 
You can also check the level on the base of the machine.

• To verify the machine level, run a Multi GR&R using the 
fiducial plate from the Tools menu. Review the x/y scatter 
plot displayed in the results screen. All of the green 
inspection points should be very close to the center of the 
target. If there is a trend toward one side, or the points are 
arranged in some symmetrical pattern, it is probably because 
the machine was not leveled correctly.
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Motor jumps and gives Amp. Fault
• Check the motor connections on the Kollmorgen drive.

• Check that the encoder phase is reversed.

No light on encoder head
• Check that the 24 V DC is connected to the drives.

• Check that the connector C2 is properly connected. For 
wiring drawings, refer to the Electrical Drawing document.

• Open the front access door and check the connections of the 
encoder cables.

No power on Kollmorgen drives
• Reset the E-Stop circuit, launch the MoCon software and 

click Reset in the Controller Summary window.

• Check that MCB Q7, Q8 and Q9 are switched on.

• Check that the 24 V power supply is on.

• Check that contactors KS2 and KS3 are at the ON position.

Gantry makes strange noise
• Launch the MoCon software. In the Controller Summary 

window, select the Config tab and check that the sample rate 
is 8000.

• If the sample rate is different, the MEI card should be 
reconfigured. 

Flashing c1 on the drives
• Check that cable (p/n 5186-6319) is connected properly 

between the MEI card in the PC and the Kollmorgen drive. 

• Reset the E-Stop circuit, launch the MoCon software and 
reset the drives.

Flashing r4 (or r5 or r6) on the drives

This means there is break in the encoder cable or the Halls are 
illegal. 

• First, press an E-Stop button, open the front access door and 
manually move the X and Y axes to the middle of the 
machine.

• Close the front access door, reset the E-Stop circuit and try 
to home the gantry.
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• If the error persists on only one drive, physically swap the 
drives using the following procedure:

a Shut down the PC, turn off the START key and disconnect 
the mains.

b Remove the rear access panel and locate the drives on the 
control panel.

c Disconnect all the cables from the drives, making notes on 
where are they connected to. 

d Physically swap the drives, and connect the cables again.

e Power up the machine, reset the E-Stop circuit, and start 
the sj5000 software.

f If the error is reported on the same drive, then the drive is 
faulty and should be replaced.

g If the error is now on the other drive, then there is a 
problem with the cable or with the encoder head. 

Note that there are two cables from the drive to the encoder 
head. Either could be faulty, so further investigation is 
needed to locate the problem. This requires a spare encoder 
head and cables.
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Errors on Kollmorgen drive

Table 11-1   Error messages

Status Display Fault Message Possible Cause

o
p
r0
r1
r2
r3
r4
r5
r6
r7
r8
r9
r10
u
H
A1
A2
J
J1
E
E
F

d5
d6
d1
d2
c

Power Stage Overtime
Over Voltage
Over Current
External Feedback Fault
Resolver Line Break
RDC Error
Sine Encoder Init Fail
A/B Line Break
Index Line Break
Illegal Halls
C/D Line Break
A/B Out of Range
Burst Pulse Overflow
Endat Communication Fault
Under Voltage
Motor Over Temperature
Positive Analog Supply Fail
Negative Analog Supply Fail
Over Speed
Over Speed
EEPROM Failure
EEPROM Checksum Fail
Foldback
Positive Over Travel Fault
Negative Over Travel Fault
Numeric Position Deviation
Excessive Position Deviation
Communication Interface

Overload, fan malfunction, power stage failure.
Excessive deceleration rate.
Power stage surge current.
Feedback signal through C8 not correctly detected.
Break in resolver feedback detected.
Fault in resolver-to-digital converted detected.
Sine encoder card has not initialized properly.
Break in encoder A\B input lines detected.
Break in encoder index line.
Illegal Hall combination detected.
Break in sine encoder C\D line detected.
Sine encoder A\B level out of range.
Sine encoder fault.
Serial communication to the end at encoder failed.
Bus voltage is too low.
Motor overload caused overheating.
Failure in +12 V supply (regulated).
Failure in –12 V supply (regulated).
Velocity VOSPD.
Velocity 1.8 x VLIM.
Faulty EEPROM.
EEPROM checksum invalid on power-up.
System in feedback mode.
PFB exceeded PMAX with PLIM = 1.
PFB exceeded PMIN with PLIM = 1.
Internal fault.
PE > PEMAX.
A communications fault has occurred.



11-42 Agilent U1840A Medalist sj5000 Hardware Manual

11 Troubleshooting



12-1

Agilent U1840A Medalist sj5000 Automated Optical Inspection System
Hardware Manual

Agilent Technologies

12
Maintenance
Overview    12-2
Weekly Maintenance    12-3
Monthly Maintenance    12-6
Quarterly Maintenance    12-8
Yearly Maintenance    12-9



12-2 Agilent U1840A Medalist sj5000 Hardware Manual

12 Maintenance

Overview

The maintenance schedule for the Medalist sj5000 consists of 
weekly monthly, quarterly, and yearly routines. The schedule 
must be strictly adhered to.

When carrying out the maintenance tasks, refer to the 
Electrical Drawing document for the circuits involved. The 
electrical drawing numbers are provided where possible.

Important Notes on Lubricants

Be sure to use a clean, dry, soft lint-free cloth for cleaning any 
dirt or dried lubricant from the linear rails.

Only use lithium based grease. The recommended lubricants 
are:

• Dow Corning’s Molykote 44

• AFB grease – multi purpose grease from the manufacturer 
THK Japan

WARNING Maintenance must only be carried out by trained personnel.

WARNING Failure to lubricate the stage at quarterly intervals may cause 
damage to the rails and invalidate all warranties.
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Weekly Maintenance

Carry out the following maintenance procedure weekly:

• Run a board through the sj5000 and ensure that it is 
operating correctly.

• Clean the machine panels.

• Clean the PC filter, if fitted.

• Check that all fans are running. 

• Check that the control panel fan is running.

• Inspect the XY table and check all cables and connectors.

• Move the XY table by hand. Ensure that it moves freely and is 
not obstructed throughout its full range of movement on both 
X and Y axes.

• Test the E-Stop circuit by opening and closing the front 
access door. Reset the E-Stop circuit using the ES Reset 
button at the front of the sj5000. 

• Test the E-Stop circuit by pressing an E-Stop button. Reset 
the E-Stop circuit by pulling out the E-Stop button and 
pressing the ES Reset button.

• Repeat this procedure for each of the other E-Stop buttons.

• Start the AWA software and home the AWA conveyor. Move it 
to a width of 100 mm and measure both sides of the conveyor 
to ensure that the calibration is good.

• Power down the machine and switch off the XY stage at the 
controller.

Figure 12-1 XY gantry
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• Ensure that the bearings are free from dust, loose particles 
and moisture.

• Ensure that the magnetic platens are free from debris.

• Visually examine the encoders on each axis to ensure that 
there are no scratches, grease, or dirt. To remove any grease 
or dirt, use a very fine lint-free cloth. 

• Take care not to scratch the XY table, as this will greatly 
affect the its accuracy.

• Check that the small home marker contacts and end limits 
are intact. Ensure that they are free from dirt and grease.

• Power up the machine. Check the function of the conveyor 
sensors (see Figure 12-2) by placing a sample board over 
them. Look at the indicator light on each of the sensors.

• Move the lighting head over each sensor and make sure they 
are not activated by it.

• Check the soundness of all motor housings.

• Wipe off edge belts with 409 spray cleaner (recommended). 
Alternatively, use alcohol.

• Open the front access door. Turn the MAINT. SWITCH to the on 
position. From the Maintenance window, operate the stops 
and clamps for each rail to ensure they move without 
obstruction.

NOTE NEVER clean the conveyor with a compressed air stream. It may cause 
dirt or other particles to get lodged in the motor shaft. Use a vacuum 
cleaner to remove loose dust or dirt.
NEVER disassemble the motors.
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Figure 12-2 Sensors on the conveyor
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Monthly Maintenance

Carry out the following maintenance procedure monthly:

• Carry out the weekly routine.

• Carefully clean the camera lens using general purpose 
cleaning solution and a lint free cloth.

• Clean and lubricate the gantry rails (shown below).

Power down the PC before performing the following checks. 

• Turn off the sj5000 using the START key switch and turn the 
mains isolator to the OFF position. Open the rear access 
panel and visually inspect the electrical control panel.

• Inspect all electrical equipment on the machine for damaged 
contacts, exposed wire and frayed insulation.

• Clean the conveyor optical sensors with a dry cloth. 

• Check that the cables going to the PC are tight.

• Check all connections on the lighting controller, terminals 
and PLC modules.

• Check all cables on the lighting head and XY table and ensure 
that none are loose or damaged.
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• When inspecting the connections on the gantry stage and at 
the controller, check the integrity of the connectors at 
random.

• Ensure that all conveyor bearings are free running and that 
belt tension is tight.

• Ensure that the conveyor belts are not twisted on either rail.
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Quarterly Maintenance

Carry out the following maintenance procedure every quarter:

• Carry out the monthly routine.

• When inspecting the control panel, check the tightness of 
several connections at random. Ensure that no wires in the 
terminals have become loose.

• Push the XY stage to one end of its travel.

• Remove any accumulated dust or debris from inside the 
assembly.

• Vacuum clean the base of the table.

• Remove any dirty or dried lubricant from the bearing guides.

• Using a clean cloth, wipe along the rails to clean the bearing 
guides. A cotton swab soaked in a general purpose white 
spirit will suffice to remove stubborn debris.

• After the solvent has evaporated (if used), apply a thin, 
continuous film of lubricant to the bearing guides. A good 
quality natural bristle artist’s brush is an excellent 
applicator for this.

• Using a grease gun with a grease nipple (type UU), lubricate 
the four bearing trucks on each gantry axis. 

WARNING Failure to lubricate the stage at quarterly intervals may cause 
damage to the rails and invalidate all warranties.
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Yearly Maintenance

Carry out the following maintenance procedure every quarter:

• Carry out the quarterly routine.

• Isolate the sj5000 from the mains supply. 

• Remove the bottom side panels and the rear access panel.

• Physically check all electrical connections in the following 
areas:

• Electrical control panel

• XY table

• PC

• Motor controller

• All earth cables

• All connectors

• Carry out the following test which gives an indication of the 
insulation resistance of the cables and whether the mains 
supply to the body of the machine is intact and complies with 
the relevant standards.

a Power off the machine.

b Switch off the mains isolator.

c Disconnect the power plugs for the monitor, PC, UPS (if 
used) and camera.

d Disconnect all AC power for the DC power supply, stepper 
drive (P403) and servo drives (Kollmorgen drives). Ensure 
that all the disconnected cables are not touching anything.

e Disconnect the AC noise filter input and output cables 
and bypass it. Also disconnect the main AC contactor and 
bypass it.

f Using an insulation resistance tester, check between L 
(cable #1) and earth (refer to the Electrical Drawing 
document). There should be a reading of > 1 Mohm. 

g Check between N (cable #2) and earth. It should have the 
same reading.

h Reconnect all cables after the insulation test.

WARNING This procedure should only be carried out by a fully qualified 
technician.
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• Check all terminal connections on the machine.

• Check the electrical connections at the conveyor motors. 
Make sure all connections are intact and securely fitted.

• Check all mounting screws and hardware on the machine.

• Systematically check all nuts, bolts and screws on rails, 
lifting mechanism, bearings and mountings for all hardware.
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Note that the system specifications may change during the 
product life of the Medalist sj5000. Any changes will be covered 
in subsequent revisions of this manual. 
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Table A-1    Software specifications

Item Specification

Operating System Windows XP

User Interface Graphical user interface with password protected 
user levels.

Data Transfer Interfaces Any ASCII file format via floppy disk, USB, CD, DVD 
or Ethernet (TCP/IP or MS Network).

Table A-2    Hardware specifications

Item Specification

Computer System HP xw4400 workstation. Key specifications are:
• Intel Core Duo E6400 2.13 2 MB/1066 CPU
• 1 GB memory
• 250 GB hard drive

Host 
Communications

Twisted pair Ethernet supporting TCP/IP or MS Network

CAD Translation 
Tool

CAMCAD

Imaging Hardware Matrox Solios Frame Grabber

Camera System DALSA 4m60 Camera:
• CCD 2352 x 1728 pixels, electronic shutter
Optics:
• 75 mm lens with low chromatic distortion 
Illumination:
• Multi-layer LED
• Pixel size of 19 µm (factory set)

XY Robot System Gantry robot system with linear motors and linear 
encoders
Travel: 510 mm
Velocity (x, y): 1500 mm/sec (60”/sec)
Encoder Resolution: 1 µm
X Motor Type: LC-50-100
Y Motor Type: LC-50-200

Board Sizes Minimum: 50 mm x 50 mm
Maximum: 510 mm x 510 mm

Board Clearance Top side 41 mm
Bottom side 50 mm
Minimum edge clearance 3.5 mm
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Conveyor System SMEMA standard conveyor supplied with speed 
adjustment. 20 mm – 550 mm per second. Conveyor length 
1.0 meters.
Conveyor height adjustable between 821 mm and 965 mm.

Position Depends on application: Post-Oven/Post-Wave

Enclosure The enclosure is designed to conform to CE Mark 
standards for electrical and mechanical industrial safety. 
Note: Auto conveyor width adjustment is available as 
standard.

Table A-3    Supply facilities specifications

Item Specification

Electricity 100–120 V, 200–240 V 50/60 Hz 
Main protection to system is 16 Amps
Normal Running Current:
100–120 V, 200–240 V Single Phase 50/60 Hz at 8 A
The use of a branch type circuit breaker at the main 
distribution panel is recommended.

Operating Temperature 5ºC to 40ºC

Table A-4    Physical dimensions

Item Specification

Footprint 1000 mm x 1250 mm without keyboard and monitor support arm

Height Approximately 2070 mm including light tower
Approximately 1550 mm excluding light tower

Weight Approximately 750 kg

Table A-2    Hardware specifications

Item Specification
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Reference Documents

The following reference documents are provided with the 
Medalist sj5000:

• Site Preparation Manual

• Operator Manual

• Electrical Drawing



B-2 Agilent U1840A Medalist sj5000 Hardware Manual

B Reference Documents


	Contents
	Safety and Regulatory Information
	Safety Information
	Electrical Safety
	Physical Safety
	System Warning/Caution Labels
	Electrostatic Discharge (ESD) Precautions
	End of Life: Waste Electrical and Electronic Equipment (WEEE) Directive 2002/96/EC

	Introduction to the Medalist sj5000
	Advantages of the Medalist sj5000
	Post-Reflow Inspection
	Camera Navigation
	Parts of the Medalist sj5000
	System Overview
	Front View
	Switch Plate
	Front Electrical Interface Module

	Rear View
	Control Panel

	Conveyor

	Power and Communications
	Electrical Power
	Communications
	SMEMA Communications
	SMEMA Connections
	Network Connection (Optional)
	Serial Connection



	Installation
	Checking the Facilities and Tools
	Unpacking the sj5000
	Moving the sj5000
	Adjusting the Height and Leveling the sj5000
	Mounting the Lighting Tower
	Installing the Keyboard and Monitor
	Connecting the Mains Cable
	Earth Cable Connection


	Starting Up the Medalist sj5000
	Before Powering Up
	Powering Up the sj5000 for the First Time
	Powering Up From the Mains Off Position
	Powering Up to Restore From an Emergency Stop
	Machine Cycle

	Changing the Conveyor Rail Width
	Sensors and Flags
	Manual Width Adjust
	Auto Width Adjust
	The Auto Width Adjust Window


	Auto Width Adjust Conveyor Setup
	Linear Mechanical Setup
	Conveyor Edge Clearance Adjustment
	AWA Mechanical Setup

	AWA Setup and Calibration
	Auto Width Adjust Calibration
	Conveyor Width Adjustment
	Testing the Move, Stop, and Jog Functions

	General Conveyor Checks
	Board Sensor Checks
	AWA Conveyor Component Alignment
	Clamp Home Sensor Adjustment
	Conveyor Speed Adjustment
	Changing Conveyor Direction

	Camera and Lighting Calibration
	Camera Calibration
	Focusing the Camera
	Setting the Lens Aperture

	Auto-Scaling
	Raising or Lowering the Camera


	Lighting Calibration
	Lighting Calibration (Manual)
	Auto Calibration
	Calibration on Location
	The Lighting Controller Window
	Lighting Calibration Files

	Lens Foreign Body Check

	Camera and Lighting Controller Testing
	Camera Testing
	Lighting Controller Testing

	Downloading PLC Programs
	Downloading Using a USB Cable
	Downloading Using the Serial Cable
	Selecting Dual or Single Lane Operation

	Setting Up Barcode Readers
	Microscan MS-4 USB Barcode Reader
	Install Microscan ESP Software
	Install USB-to-Serial Virtual Com Port Driver
	Download Barcode Reader Setup File
	Set Up Multiple Barcode Readers
	Align Barcode Reader
	Test Barcode Reader Using HyperTerminal
	Configure sj5000 Software

	Microscan MS-820 Serial Barcode Reader
	Set Up Single Barcode Reader
	Set Up Dual Barcode Reader

	Handheld Barcode Reader
	Install the Barcode Reader
	Program the Barcode Reader


	Troubleshooting
	Error Messages
	Troubleshooting the Software
	Troubleshooting the System Power
	Troubleshooting the 24 V Supply
	Troubleshooting the Conveyor
	Troubleshooting the Camera
	Troubleshooting the Lighting Controller
	Troubleshooting the Lighting Tower
	Troubleshooting the PC and Monitor
	Troubleshooting the Safety Relay
	Troubleshooting the XY Table
	Checking the System
	Check the Hardware
	Download Parameters to MEI Card and Drives
	Move the Axis
	Mapping the Axes

	Troubleshooting


	Maintenance
	Overview
	Weekly Maintenance
	Monthly Maintenance
	Quarterly Maintenance
	Yearly Maintenance

	System Specifications
	Reference Documents

